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 Introducing Publisher 2007 

 Microsoft Offi ce Publisher 2007 is a desktop publishing program with which you can 

create a wide variety of professional-looking publications intended for print or online 

presentation. Publisher provides well-thought-out templates to help you structure con-

tent within a publication (or you can start from scratch), and professionally designed 

color palettes that can quickly change an amateur publication into a masterpiece. 

 When designing multiple publications for an organization, you can automatically in-

corporate brand elements such as colors, fonts, and logos into business stationery, 

brochures, newsletters, cards, catalogs, and many other publications.   After you create a 

publication, Publisher helps you to print it, package it for professional printing, distribute 

it by e-mail, or publish it to a Web site. 

New Features
 Publisher 2007 has a lot of neat new features that simplify the process of creating a 

classy publication. We don’t indicate which features are new within the book, but we 

do list them here. To locate information about a specifi c feature, see the index at the 

back of this book. 

 If you’re upgrading to Publisher 2007 from a previous version, you’re probably more 

interested in the differences between the old and new versions and how they will affect 

you than you are in the basic functionality of Publisher. To help you identify the entire 

scope of change from the version of Publisher you’re familiar with, we’ve listed here the 

new features introduced in Publisher 2007 and in Publisher 2003. 

If You Are Upgrading from Publisher 2003
 Use these new features to create high-quality branded publications and marketing 

collateral: 

 O Apply your brand in one step With Publisher 2007, you can easily apply and view 

elements from your brand—logo, colors, fonts, and business information—to all 

templates, in one step. 

 O Template search Quickly fi nd just the right template within Publisher 2007 or on 

Microsoft Offi ce Online. Preview Offi ce Online templates within Publisher 2007. 
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 O Offi ce Online templates preview When connected to the Internet, you can 

access hundreds of Publisher templates available on Offi ce Online right from 

within Publisher 2007. 

 O Publisher Tasks Use new Publisher Tasks in Publisher 2007 for help with common 

Publisher creation and distribution procedures. 

 O Store frequently used design elements Store and reuse text, graphics, and design 

elements across Publisher publications by using the Content Library. 

 Use these new features to create effective online marketing campaigns: 

 O Personalized e-mail with E-Mail Merge Create and send personalized marketing 

communications by e-mail using E-mail Merge. 

 O Personalized hyperlinks Personalize the display text and hyperlinks to further 

personalize your e-mail merge communications. 

 O Improve navigation with bookmarks Add bookmarks to help readers quickly 

browse publications and e-mail messages. 

 O Apply an e-mail template to publications Convert a multiple-page publication 

such as a newsletter, add bookmarks, and distribute it as an e-mail message. 

 O Check your e-mail design Identify and correct potential problems with e-mail 

publications, such as text converted to an image, with the enhanced Design 

Checker. 

 Use these new features to manage and personalize lists: 

 O Combine lists within Publisher Combine, edit, and save lists from multiple 

sources—including Microsoft Offi ce Excel 2007, Microsoft Offi ce Outlook 2007, 

and Microsoft Offi ce Access 2007—within Publisher 2007 to create personalized 

print and e-mail materials or to build a publication by using Catalog Merge. 

 O Personalized hyperlinks Personalize the display text and hyperlinks to further 

personalize your e-mail merge communications. 

 O Personalization tips with Publisher Tasks Use Publisher Tasks to learn how to 

prepare a mailing list, and get tips for personalizing a mailing list, purchasing a 

mailing list, and using mailing services. 

 Use these new features to share, print, and publish publications: 

 O Publish in PDF or XPS format After installing a free add-in, you can save Publisher 

fi les in PDF or XPS fi le format for sharing, online viewing, and printing. 

 O Create press-ready PDF fi les For commercial printers using a PDF workfl ow, press-

ready PDF fi les from Publisher 2007 means easier acceptance of Publisher fi les. 
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 Use these new features to integrate Publisher with Microsoft Offi ce Outlook 2007 with 

Business Contact Manager: 

 O Create a new marketing campaign Initiate a new marketing campaign using 

Outlook 2007 with Business Contact Manager from a new toolbar within Publisher. 

Identify lists of Business Contacts or Accounts to which to distribute publications. 

 O Link to Business Contacts for tracking Create a fl yer, newsletter, e-mail mes-

sage, or other publication, and indicate which Business Contacts, Accounts, 

Opportunities, or Business Projects within Outlook 2007 with Business Contact 

Manager are to receive your publication. 

 O Search folders With improved Mail Merge and E-mail Merge functionality, you 

can now choose Outlook contacts saved to Search Folders. 

If You Are Upgrading from Publisher 2002
 In addition to the features listed in the previous section, if you’re upgrading from 

Publisher 2002 (part of the Microsoft Offi ce XP program suite), you’ll fi nd the following: 

 O Catalog Merge Use Catalog Merge to build custom materials, such as datasheets 

or catalogs, by merging text and images from a database—for example, those in 

Access, Excel, or Outlook. 

 O Baseline alignment and guides Improve the appearance of text by aligning text 

across multiple columns and evenly spacing text in columns. You can also align 

text to a baseline guide. 

 O Start your own template library Easily save, categorize, and access your own 

branded templates in My Templates within Publisher 2007. 

 O Save as picture Group and save design elements as graphics, and specify the 

image format and resolution you want to use in other programs. 

 O E-mail templates Choose from dozens of e-mail publication templates for a quick 

start to your e-mail communications. 

 O Incremental Web site upload Upload only the changes to a publication that has 

already been posted to a Web server. 

 O CMYK composite postscript Create process-color (CMYK) composite postscript 

fi les, a feature highly requested by commercial printers that makes it easier for you 

to get your Publisher publications commercially printed. 

 O Advanced print settings Create separations directly from the Print dialog box, 

including converting spot colors to process colors. 
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Publisher Basics
 As with all programs in the 2007 Microsoft Offi ce release, the most common way to start 

Publisher is from the Start menu displayed when you click the Start button at the left 

end of the Windows taskbar. 

 When you are working in a publication, here are a few things to know about the contents 

of the Publisher program window: 

 O The title bar displays the name of the active document. At the right end of the 

title bar are the three familiar buttons that have the same function in all Windows 

programs. You can temporarily hide the Publisher window by clicking the Minimize 

button, adjust the size of the window with the Restore Down/Maximize button, and 

close the active document or quit Word with the Close button. 

 O Some button names are displayed and some aren’t. Pausing the mouse pointer 

over any button for a few seconds (called hovering) displays a ScreenTip with not 

only the button’s name but also its function. 

 O Some buttons have arrows, but not all arrows are alike. If you point to a button and 

both the button and its arrow are in the same box and are the same color, clicking 

the button will display options for refi ning the action of the button. If you point to 

a button and the button is in one box and its arrow is in a different box with a dif-

ferent shade, clicking the button will carry out that action with the button’s current 

settings. If you want to change those settings, you need to click the arrow to see 

the available options. 

 O Across the bottom of the program window, the status bar gives you information 

about the current document. 

Let's Get Started!
 Publisher is a fun program to use, and after becoming familiar with the basic tools and 

techniques, there is practically no limit to the types of publications you can create. This 

book gives you straightforward instructions for using Publisher. It takes you from know-

ing little or nothing about Publisher—or, for that matter, about desktop publishing—to 

a level of expertise that will enable you to create professional-looking publications for 

printing or Web distribution. We look forward to showing you around Microsoft Offi ce 

Publisher 2007. 
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Information for Readers Running 
Windows XP

The graphics and the operating system–related instructions in this book refl ect the 

Windows Vista user interface. However, Windows Vista is not required; you can also 

use a computer running Windows XP.

Most of the differences you will encounter when working through the exercises in this 

book on a Windows XP computer center around appearance rather than functionality. 

For example, the Windows Vista Start button is round rather than rectangular and is 

not labeled with the word Start; window frames and window-management buttons 

look different; and if your system supports Windows Aero, the window frames might 

be transparent. 

In this section, we provide steps for navigating to or through menus and dialog boxes in 

Windows XP that differ from those provided in the exercises in this book. For the most 

part, these differences are small enough that you will have no diffi culty in completing 

the exercises.

Managing the Practice Files
The instructions given in the “Using the Book’s CD” section are specifi c to Windows Vista. 

The only differences when installing, using, uninstalling, and removing the practice fi les 

supplied on the companion CD are the default installation location and the uninstall 

process.

On    a Windows Vista computer, the default installation location of the practice fi les 

is Documents\Microsoft Press\SBS_Publisher2007. On a Windows XP computer, the 

default installation location is My Documents\Microsoft Press\SBS_Publisher2007. If 

your computer is running Windows XP, whenever an exercise tells you to navigate 

to your Documents folder, you should instead go to your My Documents folder.

To uninstall the practice fi les from a Windows XP computer:

 1. On the Windows taskbar, click the Start button, and then click Control Panel.

 2. In Control Panel, click (or in Classic view, double-click) Add or Remove Programs.
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 3. In the Add or Remove Programs window, click Microsoft Offi ce Publisher 2007 
Step by Step, and then click Remove.

 4. In the Add or Remove Programs message box asking you to confi rm the deletion, 

click Yes.

Important If you need help installing or uninstalling the practice fi les, please see the 

“Getting Help” section later in this book. Microsoft Product Support Services does not 

provide support for this book or its companion CD.

Using the Start Menu
To    start Microsoft Offi ce Publisher 2007 on a Windows XP computer:

 Click the Start button, point to All Programs, click Microsoft Offi ce, and then click 

Microsoft Offi ce Publisher 2007.

Folders on the Windows Vista Start menu expand vertically. Folders on the Windows XP 

Start menu expand horizontally. However, the steps to access a command on the Start 

menu are identical on both systems.

Navigating Dialog Boxes
On   a Windows XP computer, some of the dialog boxes you will work with in the exercises 

not only look different from the graphics shown in this book but also work differently. 

These dialog boxes are primarily those that act as an interface between Publisher and the 

operating system, including any dialog box in which you navigate to a specifi c location.

For example, to navigate to the GettingStarted folder in Windows XP:

 On the Places bar, click My Documents. Then in the folder content pane, double-

click Microsoft Press, SBS_Publisher2007, and then GettingStarted.

To move back to the SBS_Publisher2007 folder in Windows XP:

 On the toolbar, click the Up One Level button.

Up One LevelUp One Level

 «

 «

 «
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Features and Conventions of 
This Book

This book has been designed to lead you step by step through all the tasks you are 

most likely to want to perform in Microsoft Offi ce Publisher 2007. If you start at the 

beginning and work your way through all the exercises, you will gain enough pro-

fi ciency to be able to create quite elaborate publications with Publisher. However, 

each topic is self contained. If you have worked with a previous version of Publisher, 

or if you completed all the exercises and later need help remembering how to per-

form a procedure, the following features of this book will help you locate specifi c 

information:

O Detailed table of contents. A listing of the topics and sidebars within each 

chapter.

O Chapter thumb tabs.   Easily locate the beginning of the chapter you want.

O Topic-specifi c running heads.  Within a chapter, quickly locate the topic you want 

by looking at the running head of odd-numbered pages.

O Quick Reference. General instructions for each procedure covered in specifi c de-

tail elsewhere in the book. Refresh your memory about a task while working with 

your own documents.

O Detailed index.  Look up specifi c tasks and features and general concepts in the 

index, which has been carefully crafted with the reader in mind.

O Companion CD. Contains the practice fi les needed for the step-by-step 

exercises, as well as a fully searchable electronic version of this book and 

other useful resources.

In addition, we provide a glossary of terms for those times when you need to look up 

the meaning of a word or the defi nition of a concept.

You can save time when you use this book by understanding how the Step by Step 

series shows special instructions, keys to press, buttons to click, and so on.
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Convention Meaning
This icon at the end of a chapter introduction indicates information 

about the practice fi les provided on the companion CD for use in the 

chapter.

USE This paragraph preceding a step-by-step exercise indicates the practice 

fi les that you will use when working through the exercise.

BE SURE TO This paragraph preceding or following an exercise indicates any 

requirements you should attend to before beginning the exercise or 

actions you should take to restore your system after completing the 

exercise.

OPEN This paragraph preceding a step-by-step exercise indicates fi les that 

you should open before beginning the exercise.

CLOSE This paragraph following a step-by-step exercise provides instructions 

for closing open fi les or programs before moving on to another topic.

1
2

Blue numbered steps guide you through step-by-step exercises and 

Quick Reference versions of procedures.

1
2

Black numbered steps guide you through procedures in sidebars and 

expository text.

An arrow indicates a procedure that has only one step.

See Also These paragraphs direct you to more information about a given topic 

in this book or elsewhere.

Troubleshooting These paragraphs explain how to fi x a common problem that might 

prevent you from continuing with an exercise.

Tip These paragraphs provide a helpful hint or shortcut that makes working 

through a task easier, or information about other available options.

Important These paragraphs point out information that you need to know to 

complete a procedure.

H+> A plus sign (+) between two key names means that you must hold 

down the fi rst key while you press the second key. For example, 

“press H+>” means “hold down the H key while you press the 

> key.”

Program interface 
elements

In steps, the names of program elements, such as buttons, commands, 

and dialog boxes, are shown in black bold characters.

User input Anything you are supposed to type appears in blue bold characters.

Glossary terms Terms that are explained in the glossary at the end of the book are 

shown in blue italic characters.

 «
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Using the Book’s CD

The companion CD included with this book contains the practice fi les you’ll use as you 

work through the book’s exercises, as well as other electronic resources that will help 

you learn how to use Microsoft Offi ce Publisher 2007. 

What’s on the CD?
The following table lists the practice fi les supplied on the book’s CD. 

 Chapter Files
Chapter 1: 

Getting Started with Publisher 2007

Importing.docx
Logo.png
Opening.pub
Printing.pub

Chapter 2: 

Creating Visual Interest

Birthday at the Ritz.png
Text.docx

Chapter 3: 

Creating Colorful Cards and Calendars

Arizona10.jpg
DataSource.xlsx
FoldedCard.pub
Postcard.pub

Chapter 4: 

Marketing Your Product, Service, 

or Organization

Brochure.pub
BusinessCard.pub
Envelope.pub
Flyer.pub
Icon.png
Invoice.pub
Name.png

Chapter 5: 

Creating Text-Based Publications

ADatumNews.pub

Chapter 6: 

Communicating Your Message Online

BookSeries.pub
WineTasting.pub

In addition to the practice fi les, the CD contains some exciting resources that will really 

enhance your ability to get the most out of using this book and Publisher 2007, including 

the following eBooks:

The CD that accompanies the print edition of this book is not available with this eBook edition, although select 
CD content is available for download at http://www.microsoftpressstore.com/title/9780735622999.

http://www.microsoftpressstore.com/title/9780735622999
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O Microsoft Offi ce Publisher 2007 Step by Step

O Microsoft Computer Dictionary, 5th ed.

O First Look 2007 Microsoft Offi ce System (Katherine Murray, 2006)

O Sample chapter and poster from Look Both Ways: Help Protect Your Family on the 
Internet (Linda Criddle, 2007)

O Microsoft Offi ce Fluent Ribbon Quick Reference

O Windows Vista Product Guide

Important The companion CD for this book does not contain the Publisher 2007 

software. You should purchase and install that program before using this book.

Minimum System Requirements

2007 Microsoft Offi ce System
 The 2007 Microsoft Offi ce system includes the following programs: 

 O Microsoft Offi ce Access 2007 

 O Microsoft Offi ce Communicator 2007 

 O Microsoft Offi ce Excel 2007 

 O Microsoft Offi ce Groove 2007 

 O Microsoft Offi ce InfoPath 2007 

 O Microsoft Offi ce OneNote 2007 

 O Microsoft Offi ce Outlook 2007 

 O Microsoft Offi ce Outlook 2007 with Business Contact Manager 

 O Microsoft Offi ce PowerPoint 2007 

 O Microsoft Offi ce Publisher 2007 

 O Microsoft Offi ce Word 2007 

 No single edition of the 2007 Microsoft Offi ce system installs all of the above programs. 

Specialty programs available separately include Microsoft Offi ce Project 2007, Microsoft 

Offi ce SharePoint Designer 2007, and Microsoft Offi ce Visio 2007. 

 To run these programs, your computer needs to meet the following minimum 

requirements: 
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 O 500 megahertz (MHz) processor 

 O 256 megabytes (MB) RAM 

 O CD or DVD drive 

 O 2 gigabyte (GB) hard disk space for installation; a portion of this disk space will be 

freed if you select the option to delete the installation fi les 

 Tip Hard disk requirements will vary depending on confi guration; custom installation 

choices may require more or less hard disk space. 

 O Monitor with 800 × 600 screen resolution; 1024 × 768 or higher recommended 

 O Keyboard and mouse or compatible pointing device 

 O Internet connection, 128 kilobits per second (Kbps) or greater, for download and 

activation of products, accessing Microsoft Offi ce Online and online Help topics, 

and any other Internet-dependent processes 

 O Windows Vista or later, Microsoft Windows XP with Service Pack 2 (SP2), or 

Microsoft Windows Server 2003 or later 

 O Windows Internet Explorer 7 or Microsoft Internet Explorer 6 with service packs 

 The 2007 Microsoft Offi ce suites, including Offi ce Basic 2007, Offi ce Home & Student 

2007, Offi ce Standard 2007, Offi ce Small Business 2007, Offi ce Professional 2007, Offi ce 

Ultimate 2007, Offi ce Professional Plus 2007, and Offi ce Enterprise 2007, all have similar 

requirements. 

Step-by-Step Exercises
 In addition to the hardware, software, and connections required to run the 2007 

Microsoft Offi ce system, you will need the following to successfully complete the 

exercises in this book: 

 O  Publisher 2007, Word 2007, and Outlook 2007 

 O Access to a printer 

O 4 MB of available hard disk space for the practice fi les

Installing the Practice Files
 You need to install the practice fi les to a suitable location on your hard disk before you 

can use them in the exercises. Follow these steps: 



xx  Using the Book’s CD

 1. Remove the companion CD from the envelope at the back of the book, and insert 

it into the CD drive of your computer. 

The Step By Step Companion CD License Terms appear. Follow the on-screen 

directions. To use the practice fi les, you must accept the terms of the license 

agreement. After you accept the license agreement, a menu screen appears. 

Important If the menu screen does not appear, click the Start button and then click 

Computer. Display the Folders list in the Navigation Pane, click the icon for your CD 

drive, and then in the right pane, double-click the StartCD executable fi le. 

 2. Click Install Practice Files. 

 3. Click Next on the fi rst screen, and then click Next to accept the terms of the license 

agreement on the next screen. 

 4. If you want to install the practice fi les to a location other than the default folder 

(Documents\Microsoft Press\SBS_Publisher2007), click the Change button, select 

the new drive and path, and then click OK. 

Important If you install the practice fi les to a location other than the default, you 

will need to substitute that path within the exercises. 

 5. Click Next on the Choose Destination Location screen, and then click Install on 

the Ready to Install the Program screen to install the selected practice fi les. 

 6. After the practice fi les have been installed, click Finish. 

 7. Close the Step by Step Companion CD window, remove the companion CD from 

the CD drive, and return it to the envelope at the back of the book. 

Using the Practice Files
When you install the practice fi les from the companion CD that accompanies this book, 

the fi les are stored on your hard disk in Documents\Microsoft Press\SBS_Publisher2007. 

Each exercise is preceded by a paragraph that lists the fi les needed for that exercise and 

explains any preparations needed before you start working through the exercise. Here 

are examples: 

USE the Opening publication. This practice fi le is located in the Documents\Microsoft Press\
SBS_Publisher2007\GettingStarted folder.

BE SURE TO start your computer, but don’t start Publisher before starting this exercise.

USE the the OpeningOpening publication. This practice fi le is located in the publication. This practice fi le is located in the Documents\Microsoft Press\Documents\Microsoft Press\
SBS_Publisher2007\GettingStartedSBS_Publisher2007\GettingStarted folder.folder.dd

BE SURE TO start your computer, but don’t start Publisher before starting this exercise.start your computer, but don’t start Publisher before starting this exercise.
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 You can browse to the practice fi les in Windows Explorer by following these steps: 

  1. On the Windows taskbar, click the Start button, and then click Documents. 

  2. In your Documents folder, double-click MSP, double-click SBS_Publisher2007, and 

then double-click a specifi c chapter folder. 

 You can browse to the practice fi les from a Publisher 2007 Open Publication dialog box 

by following these steps: 

  1. In the Favorite Links pane in the dialog box, click Documents. 

  2. In your Documents folder, double-click Microsoft Press, double-click 

SBS_Publisher2007, and then double-click the specifi ed chapter folder. 

Removing and Uninstalling the Practice Files
 After you fi nish working through this book, delete the practice documents, messages, 

and other items you created while working through the exercises, and then uninstall the 

practice fi les that were installed from the companion CD. Follow these steps: 

  1. On the Windows taskbar, click the Start button, and then click Control Panel. 

  2. In Control Panel, under Programs, click the Uninstall a program task. 

  3. In the Programs and Features window, click Microsoft Offi ce Publisher 2007 
Step by Step, and then on the toolbar at the top of the window, click the Uninstall 
button.

  4. If the Programs and Features message box asking you to confi rm the deletion 

appears, click Yes. 

See Also If you need additional help installing or uninstalling the practice fi les, see “Getting 
Help” later in this book.

 Important Microsoft Product Support Services does not provide support for this book or 

its companion CD. 

StartStart

StartStart
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 Getting Help 

 Every effort has been made to ensure the accuracy of this book and the contents of its 

companion CD. If you do run into problems, please contact the sources listed below for 

assistance. 

Getting Help with This Book and Its Companion CD
 If your question or issue concerns the content of this book or its companion CD, please 

fi rst search the online Microsoft Press Knowledge Base, which provides support informa-

tion for known errors in or corrections to this book, at the following Web site: 

 www.microsoft.com/mspress/support/search.asp 

 If you do not fi nd your answer in the online Knowledge Base, or if you experience 

a technical diffi culty with the companion CD, send your comments or questions to 

Microsoft Press Technical Support at: 

 mspinput@microsoft.com 

Getting Help with Publisher 2007
 If your question is about Microsoft Offi ce Publisher 2007, and not about the content of 

this Microsoft Press book, your fi rst recourse is the Publisher Help system. This system is 

a combination of tools and fi les stored on your computer when you installed the 2007 

Microsoft Offi ce system and, if your computer is connected to the Internet, information 

available from Microsoft Offi ce Online. There are several ways to fi nd general or specifi c 

Help information: 

 O To fi nd out about an item on the screen, you can display a ScreenTip. For example, to 

display a ScreenTip for a button, point to the button without clicking it. The ScreenTip 

gives the button’s name and the associated keyboard shortcut, if there is one. 

 O From the Publisher program window, you can display the Publisher Help window by 

clicking Microsoft Offi ce Publisher Help on the Help menu.  

 O After opening a dialog box, you can click the Help button (also a question mark) at 

the right end of the dialog box title bar to display the Publisher Help window with 

topics related to the functions of that dialog box. 

http://www.microsoft.com/mspress/support/search.asp
mailto:mspinput@microsoft.com


xxiv 	 Getting	Help

To practice getting help, you can work through the following exercise. 

BE SURE TO start Publisher before beginning this exercise.

 1. At the right end of the menu bar, click the Type	a	question	for	help	box. 

 2. Type How	do	I	get	help? and then press F. 

The Publisher Help window opens. 

 3. Click the Get	help	from	Microsoft	Support	Services topic. 

Read about getting product support from Microsoft. 

 4. Click the Back button 

 5. Scroll down and click Print	a	Help	topic. 

Read about printing a help topic so that you can save it for future reference. 

BE SURE TO start Publisher before beginning this exercise.start Publisher before beginning this exercise.

BackBack
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 6. On the toolbar, click the Home button.

The main Publisher help window opens.

 7. In the list of topics in the Publisher Help window, click Activating	Publisher.

Publisher Help displays a list of topics related to activating Microsoft Office system 
programs. You can click any topic to display the corresponding information.

 8. On the toolbar, click the Show	Table	of	Contents button.

The Table Of Contents appears in the left pane, organized by category, like the 
table of contents in a book.

Clicking any category (represented by a book icon) displays that category’s topics 
(represented by help icons).

HomeHome

Show Table of 
Contents

Show Table of 
Contents
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If you’re connected to the Internet, Publisher displays categories, topics, and training 
available from the Office Online Web site as well as those stored on your computer.

	 9.	 In the Table of Contents, click a few categories and topics, then click the Back and 
Forward buttons to move among the topics you have already viewed.

CLOSE  the Publisher Help window.

More Information
If your question is about Microsoft Office Publisher 2007 or another Microsoft software 
product and you cannot find the answer in the product’s Help system, please search the 
appropriate product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/

Forward
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Quick Reference 

 1 Getting Started with Publisher 2007 
To start Publisher, page 4

 On the Start menu, click All Programs, click Microsoft Offi ce, and then click 

Microsoft Offi ce Publisher 2007. 

To display the Getting Started window, page 4

 Close any open publications, or click New on the File menu. 

To bypass the Getting Started window, page 4

 1. On the Tools menu, click Options. 

 2. On the General tab of the Options dialog box, clear the Show Publication Types 
when starting Publisher check box, and then click OK. 

 To create a publication based on a ready-made Publisher template, page 4

  1. In the Publication Types list, click the publication category you want. 

  2. In the center pane, click the thumbnail of the design you want. 

  3. In the right pane, set the publication options. Then click Create. 

 To change the template or type of an existing publication, page 7

  1. In the Format Publication task pane, under Publication Type Options, click Change 
Template. 

  2. In the Change Template window, click the new layout or publication you want 

to use. 

 To import a Microsoft Offi ce Word document, page 8

  1. In the Publication Types list, click Import Word Documents. In the center pane, 

click the design template you want to apply to the imported document. 

  2. In the right pane, under Customize, select the Color scheme, Font scheme, and 

Business information. 

 «

 «
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 3. Under Options, select the Page size and Columns, and if you want to include a title 

page, select that check box. Then click Create. 

 4. In the Import Word Document dialog box, select the fi le you want to import, and 

then click OK. 

To save a publication in a new folder, page 13

 1. On the File menu, click Save As. 

 2. On the toolbar of the Save As dialog box, click the New Folder button. 

 3. Type a name for the folder, press F, name the fi le if necessary, and then click Save. 

To save a publication as a template, page 14

 1. On the File menu, click Save As. 

 2. In the Save As dialog box, enter a name for the template in the File name box. 

 3. Click the Save as type arrow, and then in the list, click Publisher Template. 

 4. If you want to assign the template to a specifi c category, click the Change button. 

Select the category from the list or select the current category and type the name 

of a new category. Then click OK. 

 5. Click Save. 

To create a new publication based on a custom template, page 14

 1. In the left pane of the Getting Started window, under Microsoft Publisher, click 

My Templates. 

 2. In the center pane, click the template you want. Then click Create. 

To open an existing publication, page 17

 1. In the Recent Publications pane of the Getting Started window, click From File. 

 2. In the Open Publication dialog box, browse to and select the fi le you want to 

open, and then click Open. 

To move from page to page within a publication, page 17

 On the page sorter at the bottom of the window, click the page you want to display. 

To change the zoom level of a publication, page 18

 On the Standard toolbar, click the Zoom arrow, and then select the Zoom level you 

want. 

or 

 «

 «
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 On the Standard toolbar, click the Zoom In or Zoom Out button. 

To create an information set, page 20

 In the Publication Types list, click any publication type. Then in the right pane, un-

der Customize, in the Business information list, click Create new. 

or 

 1. In an open publication, on the Edit menu, click Business Information. 

 2. In the Create New Business Information Set dialog box, enter information you 

want to save as part of the information set. If any information does not apply, 

delete it. 

 3. Below the Logo box, click Remove to clear the current logo, or click Change and 

then in the Insert Picture dialog box, browse to and select the logo you want to 

use, and click Open. 

 4. In the Business Information set name box, enter a name for the information set. 

Then click Save. 

To preview a publication as it will appear when printed, page 24

 On the Standard toolbar, click the Print Preview button. 

To print a publication, page 25

 1. On the File menu, click Print. 

 2. In the Print dialog box, change any settings that apply, and then click OK. 

 2 Creating Visual Interest 
To create a blank publication, page 32

 1. In the Publication Types list, click Blank Page Sizes. In the center pane, click the 

design you want. 

 2. In the right pane, under Customize, select the Color scheme, Font scheme, and 

Business information. Then click Create. 

To add a text box, page 33

 1. Click the Text Box button on the Objects toolbar, or click Text Box on the Insert 
menu. 

  2. Drag to draw a text box of the size you want. 

 «

 «

 «
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To insert the contents of an external document into a text box, page 34

 1. With the insertion point in the text box, click Text File on the Insert menu. 

 2. In the Insert Text dialog box, browse to and select the fi le you want, and click OK. 

To format a text box, page 34

 Double-click the text box frame. Then in the Format Text Box dialog box, make the 

formatting changes you want, and click OK. 

To format the text in a text box, page 35

 Select the text you want to format. Then use the commands on the Format menu 

or Formatting toolbar to make the changes you want. 

To add a WordArt object to a publication, page 39

 1. Click the Insert WordArt button on the Objects toolbar, or point to Picture on the 

Insert menu, and then click WordArt. 

 2. In the WordArt Gallery, click the style you want, and then click OK. 

 3. In the Edit WordArt Text dialog box, enter the text you want, and then click OK. 

To modify the appearance of a WordArt object, page 40

 1. Select the WordArt object. On the WordArt toolbar, click the WordArt Shape 

button, and then in the gallery, click the shape you want. 

 2. On the WordArt toolbar, click the Format WordArt button. In the Format 
WordArt dialog box, change any settings you want, and then click OK. 

To add an image from a fi le to the Clip Organizer, page 44

 1. At the bottom of the Clip Art task pane, click Organize clips. 

 2. In the Collection List pane of the Microsoft Clip Organizer window, under My 
Collections, click the Favorites folder. 

 3. On the window’s File menu, point to Add Clips to Organizer, and then click On 
My Own. 

 4. In the Add Clips to Organizer dialog box, browse to and select the fi le you want to 

add, and then click Add. 

To delete a clip art image from the Clip Organizer, page 44

 In the Microsoft Clip Organizer window, point to the image, click the arrow 

that appears, click Delete From Clip Organizer, and then click OK to confi rm the 

deletion. 

 «

 «

 «
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To add keywords to an image, page 44

 1. In the Microsoft Clip Organizer window, point to the image, click the arrow that 

appears, and then click Edit Keywords. 

 2. In the Keyword box of the Keywords dialog box, type the word or words that you 

want to associate with this fi le (separating words and phrases with commas), and 

then click Add. 

To insert a clip art image, page 46

 1. Click the Picture Frame button on the Objects toolbar or point to Picture on the 

Insert menu, and then click Clip Art. 

 2. In the Clip Art task pane, do the following: 

 a. In the Search for box, enter a word or words describing the picture you want.  

 b. In the Search in list, select the collections you want to search.  

 c. In the Results should be list, select the fi le types you want the search to 

return.  

 d. Click Go. 

 3. In the results list, click the thumbnail you want to insert. 

 4. Drag the image frame sizing handles to size the image to fi t the available space. 

To insert an image from a fi le, page 49

 1. Click the Picture Frame button on the Objects toolbar, and then click Picture from 
File; or point to Picture on the Insert menu, and then click From File. 

 2. In the Insert Picture dialog box, browse to and select the picture you want to insert, 

and then click Insert. 

To display only a portion of an inserted image, page 50

 1. Select the image. Then on the Picture toolbar, click the Crop button. 

  2. Drag the cropping handles to position the crop marks where you want them. 

 To delete the cropped area of an image or minimize the fi le size of an inserted 
image, page 51

  1. Select the image. Then on the Picture toolbar, click the Compress Pictures button. 

  2. In the Compress Pictures dialog box, set the compression options, target output, 

and scope. Then click Compress.  

  3. If Publisher prompts you to do so, click Yes to apply picture optimization. 
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To insert a shape, page 54

 1. Click the AutoShapes button on the Objects toolbar or point to Picture on the 

Insert menu, and then click AutoShapes.  

  2. On the detachable AutoShapes toolbar, point to the shape category you want, and 

then click the shape you want to insert. 

  3. Drag the pointer across the page to draw a shape of the size you want. 

 To format shapes, page 54

  1. To change the shape’s direction, on the Arrange menu, point to Rotate or Flip, and 

then click Flip Vertical. 

  2. Double-click the shape, and on the Colors and Lines tab of the Format AutoShape 

dialog box, change the Color setting under Fill to what you want, and change any 

other settings you want. Then select the Apply settings to new AutoShapes check 

box, and click OK. 

 3. On the Objects toolbar, click the button of the shape you want (such as the Oval 

button), hold down the G key, and drag to create a shape. 

 4. Double-click the line (not its handle), and under Line on the Colors and Lines tab 

of the Format AutoShape dialog box, change the Color and Weight to what you 

want. Then click OK. 

To connect shapes, and then format the connection line, page 55

 1. Click the AutoShapes button on the Objects toolbar or point to Picture on the 

Insert menu, and then click AutoShapes.  

  2. On the detachable AutoShapes toolbar, point to Connectors, and then click the 

type of connector you want. 

  3. Point to the fi rst shape you want to connect, and when blue handles appear, drag a 

line from the shape to another shape. 

 To group shapes or design elements, page 56

  Select the items you want to group by holding down the G key as you click each 

one in turn. Then on the Arrange menu, click Group. 

 To ungroup shapes or design elements, page 56

  Click the grouped object, and then click the Ungroup Objects button that 

appears. 

 «

 «
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To insert a ready-made element from the Design Gallery into a publication, 
page 58

 1. Click the Design Gallery Object button on the Objects toolbar, or click Design 
Gallery Object on the Insert menu.  

 2. In the left pane of the Design Gallery, click the category you want, and in the right 

pane, click the object you want. Then click Insert Object. 

 3 Creating Colorful Cards and Calendars 
To create a folded card based on a layout template, page 69

 1. In the Publication Types list, click Invitation Cards. In the center pane, click the 

design you want. 

 2. Under Customize in the right pane, select the Color scheme, Font scheme, and 

Business information.  

 3. Under Options, select the Page size and Layout (if these options are available for 

the selected card design). Then click Create. 

To create a postcard, page 78

 1. In the Publication Types list, click Postcards. In the center pane, click the design 

you want. 

 2. Under Customize in the right pane, select the Color scheme, Font scheme, and 

Business information.  

 3. Under Options, select the Page size and Side 2 information. Then click Create. 

To merge a publication with a data source, page 79

 1. In the open publication, on the Tools menu, point to Mailings and Catalogs, and 

click Mail Merge. 

 2. With the Use an existing list option selected under Create recipient list, click Next: 
Create or connect to a recipient list at the bottom of the task pane. 

 3. In the Select Data Source dialog box, navigate to the recipient list you want, and 

double-click it. 

 4. In the Select Table dialog box, select the data you want, and then click OK. 

 5. In the Mail Merge Recipients dialog box, change any settings you want or use the 

default settings, and then click OK. 



xxxiv  Quick Reference

 6. By clicking the links under More Items in the task pane, insert the fi elds you want 

to include in the merged publication. 

 7. At the bottom of the Mail Merge task pane, click Next: Create merged 
publication. 

 8. In the task pane, click Merge to a new publication. Then on the page sorter, click 

each page in turn to see the results. 

To create a calendar, page 88

 1. In the Publication Types list, click Calendars. In the center pane, click the design 

you want. 

 2. In the right pane, under Customize, select the Color scheme, Font scheme, and 

Business information.  

 3. Under Options, select the Page size and Timeframe.  

 4. If you want to create a calendar for other than the current time period, click Set 
Calendar Dates, choose the time period, and then click OK. 

 5. If the Include schedule of events option is available and you want to create a 

smaller calendar that includes a text area for events or other information, select 

that check box. 

 6. Click Create. 

To replace an image, page 89

 1. Right-click the existing picture, point to Change Picture, and then click From File.  

 2. In the Insert Picture dialog box, browse to and select the picture you want, and 

then click Insert. 

To switch between task panes, page 91

 On the task pane title bar, click the Other Task Panes button, and then click the 

task pane you want to display. 

To apply a background to a publication, page 91

 In the Background task pane, select the background color and gradient you want. 

or 

 In the Background task pane, click More backgrounds, and then specify the 

gradient, texture, pattern, picture, and/or tint you want. 

 «

 «
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To install the Microsoft Save As PDF Or XPS add-in, page 93

 1. Start your default Internet browser, and go to offi ce.microsoft.com/en-us/downloads/.

 2. In the left pane, under By Version, click 2007 Offi ce System, click 2007 Microsoft 
Offi ce System, and then click Add-ins. 

  3. In the list of add-ins, click 2007 Microsoft Offi ce Add-in: Microsoft Save As PDF 
or XPS. 

  4. On the installation page, click Continue. After the Genuine Advantage Tool con-

fi rms that you are running genuine, licensed software, click Install and follow the 

installation instructions given. 

 5. After the installation completes, navigate to the publication you want to submit to 

a printer, and then double-click it. 

To create a CD or fi le package containing all the fi les necessary to submit a 
publication to a professional printer, page 94

 1. On the File menu, point to Pack and Go, and then click Take to a Commercial 
Printing Service. 

 2. In the Take to a Commercial Printing Service task pane, click Printing Options. 

 3. In the Print Options dialog box, apply any settings necessary, and then click OK. 

 4. At the bottom of the task pane, click Save. 

 5. Insert a blank CD in your CD burner, and with Burn to disc on D:\ (or the equiva-

lent drive on your computer) selected, click Next. If your computer does not have a 

CD burner, select the Other Location option instead, and then browse to the folder 

in which you want to store the package. 

 6. When the wizard announces that your publication is successfully packed, clear the 

Print a composite proof check box, and then click OK. 

 4 Marketing Your Product, Service, or Organization 
To create an envelope, page 105

 1. In the Publication Types list, click Envelopes. In the center pane, click the design 

you want. 

 2. In the right pane, under Customize, select the Color scheme, Font scheme, and 

Business information. 

 3. Under Options, select the Page size and whether to include a logo image. Then 

click Create. 
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To edit a logo and add it to the Content Library, page 106

 1. On the Objects toolbar, click the Design Gallery Object button, and in the left 

pane of the Design Gallery, click Logos. If necessary, enlarge the gallery window by 

dragging its border so you can see the logos in the center pane. 

 2. In the center pane, click the style of logo you want to create, set any other options 

necessary, and then click Insert Object. 

 3. Drag the logo to the area of the publication you want. 

 4. On the Arrange menu, click Ungroup, and then click a blank area of the publication 

to release the selection and enable editing of the individual logo elements. 

 5. Make any edits and add any images you want to the logo. Then select the elements 

in the logo (hold down the G key as you click each one), and group them. 

To add an object to the Content Library, page 107

 1. Right-click the object, and then click Add to Content Library.  

 2. In the Add Item to Content Library dialog box, enter a name for the object in the 

Title box. 

 3. If you want to assign the object to a category that doesn’t appear in the Categories 
list, click the Edit Category List button, add, delete, or rename categories, and then 

click OK. 

 4. In the Categories list, select the check box of any category you want to assign the 

object to. Then click OK. 

To change the grid proportions, page 116

 1. On the Arrange menu, click Layout Guides, and then in the Layout Guides dialog 

box, click the Grid Guides tab. 

 2. Under Column Guides, change the Columns setting, and under Row Guides, 

change the Rows setting to what you want. Then click OK. 

To align objects, page 117

 Select the object or objects you want to align with each other or relative to the 

margin guides. Then on the Arrange menu, point to Align or distribute, and click 

the alignment or distribution option you want. 

To change the stacking order of an object, page 117

 Select the object you want to change the position of. Then on the Arrange menu, 

point to Order, and click the change of position you want. 

 «

 «
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To create a text watermark, page 122

 1. Insert a text box, size it to span the page, and then rotate it to the angle you want. 

 2. Enter the watermark text in the text box, select the text, and set the font and size 

so that the text fi lls the box. 

 3. On the Formatting toolbar, click the Font Color arrow, and then click Fill Effects. 

 4. In the Fill Effects dialog box, set the Base color to the color you want. Then click 

one of the three lightest Tint/Shade boxes (10%, 20%, or 30%), and click OK. 

To create a graphic watermark, page 122 

 Insert and size the graphic as usual. Then on the Picture toolbar, click the Color 
button, and in the list, click Washout. 

To link text boxes to fl ow text from one to the other, page 128

 1. Select the fi rst text box you want to link. Then on the Connect Text Boxes toolbar, 

click the Create Text Box Link button.  

 2. Move the pointer over an empty text box, and when the pointer changes to a 

pouring pitcher, click the mouse button. 

To unlink text boxes, page 128

 Select the text box that has the forward link you want to remove. Then on the 

Connect Text Boxes toolbar, click the Break Forward Link button. 

 To change the text wrapping style of a photograph, page 129

  1. Click the photograph, and then on the Picture toolbar, click the Format Picture 

button.  

  2. On the Layout tab of the Format Picture dialog box, under Wrapping Style, click 

the style you want, and then click OK. 

  5 Creating Text-Based Publications 
 To replace placeholder text, page 138

  Click the placeholder text, and then enter the text you want. 

 To automatically size text to fi t the text box in which it appears, page 139

  Select the text box. Then on the Format menu, point to AutoFit Text, and click 

Shrink Text On Overfl ow. 

 «

 «

 «

 «
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To add pages to a newsletter, page 141

 On the Insert menu, click Duplicate Page to insert a page with the same layout as 

the previous page. 

or 

 1. On the Insert menu, click Page. 

 2. In the Insert Newsletter Page dialog box, in the Available page types list or in the 

Left-hand page and Right-hand page lists, click the page type you want to insert. 

Then click OK. 

or 

 1. On the Insert menu, click Page. Then in the Insert Newsletter Page dialog box, 

click More. 

 2. In the Insert Page dialog box, select the number of pages to insert, the insertion 

location, and the page content. Then click OK. 

To apply or reapply a font theme to an existing publication, page 143

 Display the Font Schemes section of the Format Publication task pane. Then in the 

Apply a font scheme list, click the font scheme you want. 

To trace the continuation of a story in a newsletter, page 152

 Click the Go to Previous Text Box and Go to Next Text Box buttons. 

To move pages in a newsletter, page 153

 To move a two-page spread, in Two-Page Spread view, on the page sorter, drag 

either page to the new location. 

 To move one page, turn off Two-Page Spread view. Then on the page sorter, drag 

the page to the new location. 

To insert or remove Continued notices, page 153

 1. Select the text box. On the Format menu, click Text Box. 

 2. On the Text Box tab of the Format Text Box dialog box, clear or select the Include 
“Continued on page…” check box. 

To format text in columns, page 154

 Click the Columns button. Then in the Columns dialog box, set the number of 

columns you want, and click OK. 

 «

 «

 «

 «

 «
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To delete a page from a newsletter, page 157

 On the page sorter, right-click the page button of the page you want to delete, 

and click Delete Page. Then in the Microsoft Offi ce Publisher message box, click 

Yes to confi rm the deletion of the page, including the empty text box. 

To create a publication from a Microsoft Offi ce Online template, page 164

 1. In the Publication Types list, click the publication type you want to search for. 

 2. In the center pane, under Microsoft Offi ce Online Templates, click View templates 
from Microsoft Offi ce Online. 

 3. Select a template you like, and then click Create. 

To edit a story by using Microsoft Offi ce Word, page 165

 Right-click the main placeholder text, point to Change Text, and then click Edit 
Story in Microsoft Word. 

To check the spelling of a publication, page 166

 1. On the Tools menu, point to Spelling, and then click Spelling. 

 2. In the Check Spelling dialog box, correct any errors that appear, by accepting the 

suggestion or entering any replacement text you want in the Change to box. Then 

click Change to effect the replacement and move to the next detected error. 

 3. In the Microsoft Offi ce Publisher dialog box that appears when the spelling check 

is complete, click OK. 

 6 Communicating Your Message Online 
To create an e-mail message from a template, page 172

 1. In the Publication Types list, click E-mail. In the center pane, click the design you 

want. 

 2. Under Customize in the right pane, select the Color scheme, Font scheme, and 

Business information. Then click Create. 

To select a group of objects, page 174

 On the Objects toolbar, click the Select Objects button. Then drag a box to 

encompass the objects you want to select. 

 «

 «

 «
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To view the source code of an e-mail message, page 175

 1. On the File menu, point to Send E-mail, and then click E-mail Preview. 

 2. Right-click the HTML page, and then click View Source. (If you’re using a browser 

other than Windows Internet Explorer, click the equivalent command.) 

To send a publication as an e-mail message, page 176

 1. On the File menu, point to Send E-mail, and then click Send as Message. 

 2. If the Send as Message dialog box appears, click Send all pages or Send current 
page only, and then click OK. 

 3. If you have multiple e-mail accounts confi gured, select the account from which you 

want to send the message. 

 4. Address and send the message. 

To merge an e-mail message with a data source, page 178

 1. Open the e-mail publication. Then on the Tools menu, point to Mailings and 
Catalogs, and then click E-mail Merge. 

 2. In the E-mail Merge task pane, complete each of the following steps, clicking the 

Next link as you fi nish each step: 

 a. Creating or connecting to the recipient list 

 b. Preparing the publication 

 c. Sending the merged publication 

To add a publication as a top-level page to a Web site, page 188

 1. Open the publication in Publisher. On the File menu, click Publish to the Web. 

 2. In the Publish to the Web dialog box, browse to your Web site directory structure, 

name the fi le, and then click Save to save an HTML version of the fi le. 

 3. Open the site in Publisher. Click anywhere on the navigation bar, and then click the 

Navigation Bar Options button that appears. 

 4. In the Navigation Bar Properties dialog box, click Add Link. 

 5. In the Add Link dialog box, in the Link to list, click Existing File or Web Page. Then 

in the Look in pane, browse to the HTML version of the fi le. 
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 6. In the Text to display box, enter the text you want to appear on the navigation link. 

Then click OK. 

 7. To change the position of the linked fi le within the navigation link structure, click 

the Move Up and Move Down buttons. When the navigation links appear in the 

order you want, click OK in the Navigation Bar Properties dialog box. 

 To create a Web site based on a template, page 189

  1. In the Publication Types list, click Web Sites. In the center pane, click the design 

you want. 

  2. Under Customize in the right pane, select the Color scheme, Font scheme, and 

Business information. 

  3. Under Options, select the Navigation bar location. Then click Create. 

 To customize the navigation bar links, page 191

  1. Click anywhere on the navigation bar, and then click the Navigation Bar Options 
button that appears. 

  2. In the Navigation Bar Properties dialog box, in the Links list, click the link you 

want to move, and then click Move Down or Move Up until it’s in the position 

you want. 

 To confi gure a command button on a form, page 192

  1. Right-click the button, and then click Format Form Properties. 

  2. In the Command Button Properties dialog box, accept or change the button text. 

Then click Form Properties. 

  3. In the Form Properties dialog box, select the data retrieval method and the in-

formation appropriate to that method. Then click OK in each of the two open 

dialog boxes. 
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Chapter at a Glance  2 2 Creating Visual  Creating Visual 
  Interest  Interest
In this chapter, you will learn to:

� Work with text boxes.

� Work with WordArt.

� Work with graphics.

� Work with shapes.

� Work with pre-designed visual elements.

Microsoft Offi ce Publisher 2007 is specifi cally designed to make it easy to create publica-

tions that contain a mixture of text and visual elements arranged in frames on the page. 

Knowing basic techniques for inserting and manipulating visual elements is the key to 

quickly assembling impressive publications. 

 The publications you create are most effective when you achieve the balance of text 

and graphics that best conveys your message. Some publications convey information 

through text and include visual elements only to catch the reader's eye or to reinforce or 

illustrate a point. At the other end of the scale, some publications include almost no text 

and instead rely on visual elements to carry the message. 

In this chapter, you will fi rst create a text object and see how to enhance the text with 

color and formatting. Then you will use WordArt to create fancy, stylized text for those 

occasions when regular formatting doesn't quite meet your needs. Next, you will insert 

clip art graphics and pictures, add borders, and change the size, color, and position of 

the images. You will draw, connect, and group shapes. Finally, you will insert ready-made 

design elements from the Design Gallery. The instructions in the exercises assume that 

you are working in a blank publication so that you can focus on the techniques you are 

learning. However, you can easily adapt the instructions to any type of publication. 

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxvii–xli.



30  Chapter 2 Creating Visual Interest

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xvii for more information. 

Troubleshooting Graphics and operating system–related instructions in this book re-

fl ect the Windows Vista user interface. If your computer is running Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book. 

Working with Text Boxes
When you create a document by using a word processing program such as Microsoft 

Offi ce Word 2007, you enter text on the page in the area defi ned by the margins. When 

you create a publication by using Publisher, however, you enter each section of text in 

a text box. You can create text boxes or manipulate the text boxes that are part of a 

Publisher template. The text box is an object that can be sized to fi t the text it contains. 

You can type text directly into the text box, paste text from another fi le, or insert the 

entire contents of another fi le. 

In Publisher, the text in a text box is called a story.  A story is any discrete block of text 

that occupies a single text box or a set of linked text boxes. It can be a single paragraph 

or multiple paragraphs.

See Also For information about linking text boxes, see "Solving Organization Problems" in 
Chapter 5, "Creating Text-Based Publications."

Manipulating a Text Box
 After you create a text box, or when you click a text box to make it active, you can move 

it by dragging its frame.  

 Tip To copy a text box, hold down the Ctrl key while you drag it. 

 You can drag the handles of the frame to change the size or shape of the box. If you 

want a specifi c size or shape, you can change the settings on the Size page of the Format 

Text Box dialog box. In this dialog box, you can also specify the following: 

 O The background color of the text box, whether it has a border, and the color of the 

border. 

Troubleshooting Graphics and operating system–related instructions in this book re-Graphics and operating system–related instructions in this book re-

fl ect the Windows Vista user interface. If your computer is running Windows XP and youfl ect the Windows Vista user interface. If your computer is running Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.



O The position of the text box on the page, and how text in adjacent frames fl ows 

around this text box. 

O The vertical text alignment, the margins, and whether Publisher can automatically 

adjust the size of the text box to fi t the amount of text you insert in it. 

When a text box is active, a green rotating handle is attached to its upper-middle handle. 

You can drag this handle to change the angle of the text box and the text within it. 

Tip You can change the direction of text within the text box from horizontal to vertical 

by clicking the Rotate Text Within AutoShape By 90o option on the Text Box page of the 

Format Text Box dialog box. You can rotate the entire box by clicking Rotate Or Flip on the 

Arrange menu and then selecting one of the options. 

Formatting Text for Visual Impact
Brief splashes of text, such as those on a postcard or in a fl yer, need to have more visual 

impact than longer blocks of text, such as those in a newsletter. You can vary the look of 

text by changing the character formatting: 

O All text is displayed in a particular font consisting of alphabetic characters, numbers, 

and symbols that share a common design. 

 O Almost every font comes in a range of font sizes, which are measured in points 
from the top of letters that have parts that stick up (ascenders), such as h, to the 

bottom of letters that have parts that drop down (descenders), such as p. A point is 

approximately 1/72 of an inch. 

 O Almost every font comes in a range of font styles. The most common are regular 

(or plain), italic, bold, and bold italic. 

 O Fonts can be enhanced by applying font effects, such as underlining, small capital 

letters (small caps), or shadows. 

O A palette of harmonious font colors is available, and you can also specify custom 

colors. 

O You can alter the character spacing by pushing characters apart or squeezing them 

together. 

In this exercise, you will create a blank publication, add a text box, and then insert the 

contents of an existing Word document. You will then format the text box by fi lling it 

with color and format the text by changing its character formatting. 

 Working with Text Boxes  31
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USE the Text document. This practice fi le is located in the Documents\Microsoft Press\
SBS_Publisher2007\VisualInterest folder.

 1. On the Start menu, click All Programs, click Microsoft Offi ce, and then click 

Microsoft Offi ce Publisher 2007. 

 2. In the Publication Types list, click Blank Page Sizes.  

 3. In the Blank Page Sizes pane, under Standard, click the Letter (Portrait) thumbnail. 

Then click Create. 

Tip If a publication is open, you can create a new blank publication by clicking the 

New button on the Standard toolbar. 

Publisher creates a blank publication of the selected size. Blue margin guides des-

ignate the margins of the publication, which by default are set to 1 inch on all sides. 

To the left is the Format Publication task pane, and docked on the left side of the 

window is the Objects toolbar. 

USE the the TextText document. This practice fi le is located in thedocument. This practice fi le is located in thett Documents\Microsoft Press\Documents\Microsoft Press\
SBS_Publisher2007\VisualInterestSBS_Publisher2007\VisualInterest folder.folder.tt



Tip Throughout this chapter, we work with letter-size publications, but you can 

choose any size you want. You might want to try a different size for each exercise to 

see some of the available options. 

 4. Close the Format Publication task pane. Then on the Objects toolbar, click the Text 
Box button. 

 5. Move the cross-hair pointer over the blank page, and when the pointer is slightly 

to the right of the left margin guide and slightly below the top margin guide, hold 

down the mouse button, and drag to the right and down, without releasing the 

mouse button. 

Notice as you drag that Publisher displays the exact coordinates of the upper-left 

corner (the anchor point) of the text box and its exact dimensions on the status bar. 

The anchor point coordinates are expressed in relation to the upper-left corner of 

the page. 

Text box anchor point

Text box dimensions

 6. Release the mouse button when the text box dimensions are 5.000 x 2.000 in. 

A blinking insertion point in the text box shows where any text you type will 

appear. 

Text BoxText Box
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 7. Without clicking anything else, on the Insert menu, click Text File. 

The Insert Text dialog box opens, displaying the contents of your Documents folder.  

See Also For information about how to move around in dialog boxes such as this one, 
see “Saving and Closing Publications” in Chapter 1, “Getting Started with Publisher 2007.”

 8. Navigate to the Documents\Microsoft Press\SBS_Publisher2007\VisualInterest folder, 

and double-click the Text document. 

Publisher inserts the contents of the document into the text box. 

 9. On the Standard toolbar, click the Zoom arrow, and change the zoom level to 100%. 

  10. Point to the frame around the text box, and when the pointer changes to a four-

headed arrow, drag the frame down and to the right, releasing the mouse button 

when the text box coordinates are 2.000, 2.000 in. 

 Tip Publisher can display measurements in inches, centimeters, picas, points, or 

pixels. To change the unit of measure, click Options on the Tools menu, and then 

on the General tab of the Options dialog box, select the unit type you want in the 

Measurement Units list. 

  11. Double-click the text box frame to open the Format Text Box dialog box. 

ZoomZoom



 12. On the Colors and Lines tab, under Fill, click the Color arrow, and in the default 

color palette, click the orange square (Accent 3). Then click OK. 

See Also For information about applying a different color scheme and using custom 
colors, see “Creating Folded Cards” in Chapter 3, “Creating Colorful Cards and 
Calendars.”

 13. On the Edit menu, click Select All to select all the text in the text box. 

Tip You can also select all the content in a box by pressing Ctrl+A. 

 14. On the Formatting toolbar, click the Font arrow, and then in the list, click Verdana. 

See Also For information about using font schemes, see “Choosing a Font Scheme” in 
Chapter 4, “Marketing Your Product, Service, or Organization” and “Solving Organization 
Problems” in Chapter 5, “Creating Text-Based Publications.”

  15. On the Formatting toolbar, click the Increase Font Size button twice, to increase 

the font size to 12 points. 

 If the font is too big, you can click the Decrease Font Size button. You can select a 

specifi c point size by clicking the Font Size arrow and clicking the size in the list. 

Increase Font 
Size

Increase Font 
Size
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 16. On the Formatting toolbar, click the Font Color arrow, and in the default color 

palette, click the white square (Accent 5). Then click anywhere in the text box to 

release the selection. 

Tip To apply the color currently shown on the Font Color button, simply click the 

button (not its arrow). 

 17. Drag the bottom handle of the text box frame upward, releasing the mouse button 

when the dimensions shown on the status bar are 5.000 x 1.500 in.

 Troubleshooting If the dimensions don’t change but the coordinates do, you missed 

the handle and moved the text box by dragging its frame instead of the handle. On the 

Standard toolbar, click the Undo button, and then try dragging the handle again. 

 18. Select the heading What Is Fourth Coffee? by dragging across or double-clicking 

it, and then click the Increase Font Size button fi ve times to increase the font size 

to 22 points. 

 19. With the heading still selected, on the Format menu, click Font to open the Font 
dialog box. 

Font ColorFont Color

Troubleshooting If the dimensions don’t change but the coordinates do, you missed If the dimensions don’t change but the coordinates do, you missed 

the handle and moved the text box by dragging its frame instead of the handle. On the the handle and moved the text box by dragging its frame instead of the handle. On the 

Standard toolbar, click the Undo button, and then try dragging the handle again.Standard toolbar, click the Undo button, and then try dragging the handle again.



The Sample box shows the formatting applied to the selection. As you make 

changes to the settings in the dialog box, the sample changes to show how the 

selection will look if you click Apply or OK. (Clicking Apply implements the current 

settings without closing the dialog box.) 

 20. Click the Font style arrow, and in the list, click Bold. Then under Effects, select the 

Small caps check box, and click OK. 

You can click buttons on the formatting toolbar to change the font style of text, 

but to apply font effects, you have to use the Font dialog box. If you want to apply 

several attributes to the same text, it is often quicker to open the dialog box and 

apply them all from there. 

 21. On the Format menu, click Character Spacing to open the Character Spacing 

dialog box. 

 22. Under Tracking, click the arrow of the left box, and in the list, click Very Loose. 

Then click OK. 

Tip To copy the formatting of one word or phrase to another, select the text whose 

formatting you want to copy, click the Format Painter button on the Standard toolbar, 

and then select the text onto which you want to “paint” the formatting. 

 Working with Text Boxes  37



38  Chapter 2 Creating Visual Interest

 23. Click outside the text box to release the selection and see the results. 

CLOSE the publication without saving your changes.

Working with WordArt
If you want to add a fancy title to a publication, and you can’t achieve the effect you want 

with regular text formatting, you can use WordArt. With WordArt, you can visually enhance 

text in ways that go far beyond changing a font or font effect, simply by choosing a style 

from a set of small thumbnail images arranged in a gallery. 

Tip For the best results, use WordArt to emphasize short phrases, such as Customer 
Service, or a single word, such as Welcome. Overusing WordArt can clutter your publication 

and draw attention away from your message. 

You add stylized text to a publication by clicking the WordArt button on the Objects 

toolbar. You then select a style from the WordArt gallery, enter your text, and apply any 

additional formatting. Publisher inserts the text in your publication as a WordArt object 

that you can size and move like any other object. You can also change the shape of the 

object to stretch and form the letters of the text in various ways. 

In this exercise, you will add a WordArt object to a publication and then modify the 

appearance of the text. There is no practice fi le for this exercise. 



OPEN a blank publication, and then close the Format Publication task pane.

  1. On the Objects toolbar, click the Insert WordArt button. 

 The WordArt Gallery opens, displaying the available styles. 

  2. Click the fi rst thumbnail in the third row (the orange and yellow sample), and then 

click OK. 

 The Edit WordArt Text dialog box opens so that you can enter the text you want to 

depict as WordArt. 

OPEN a blank publication, and then close the Format Publication task pane.a blank publication, and then close the Format Publication task pane.

Insert WordArtInsert WordArt
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 3. With the placeholder text selected, type Fourth Coffee, and then click OK. 

The formatted text appears as an object in the center of the page, and Publisher 

displays the WordArt toolbar. 

Tip You can display the name of each button on the WordArt toolbar by pointing 

to it. The button names will give you some idea of the formatting you can apply to a 

WordArt object to get the effect you want. 

 4. If necessary, move the toolbar out of the way. Then move and resize the WordArt 

object until it spans the top of the page and is about 2 inches high. 

Tip Notice that the pointer position is always shown on the horizontal and vertical 

rulers. When dragging an object’s sizing handle, you can use the insertion point posi-

tion to align the sizing handle with the ruler units. 

 5. On the WordArt toolbar, click the WordArt Shape button, and then in the gallery, 

click the third thumbnail in the fi rst row (Triangle Up). 

Troubleshooting If you click outside the WordArt object, it is no longer active, and 

the WordArt toolbar disappears. Click the WordArt object once to reactivate it and 

display the toolbar. 

 6. On the WordArt toolbar, click the Format WordArt button. 

WordArt ShapeWordArt Shape

Troubleshooting If you click outside the WordArt object, it is no longer active, andIf you click outside the WordArt object, it is no longer active, and

the WordArt toolbar disappears. Click the WordArt object once to reactivate it and the WordArt toolbar disappears. Click the WordArt object once to reactivate it and 

display the toolbar.display the toolbar.

Format WordArtFormat WordArt



The Format WordArt dialog box opens. This dialog box resembles the Format Text 

Box dialog box shown earlier in this chapter. 

 7. Under Fill on the Colors and Lines tab, click the Color arrow, and then click Fill 
Effects. 

The Fill Effects dialog box opens. 

 8. With Two colors selected under Colors on the Gradient tab, click the Color 1 

arrow, and in the default palette, click the Purple box. Then in the Color 2 list, 

click the Gray box. 

  9. Under Shading styles, click Horizontal, and under Variants, click the lower-left 

option. Then click OK twice. 

  10. Drag the yellow diamond handle to the left of the frame up until the dotted outline 

of the letters is aligned with about the half-inch mark on the vertical ruler. 

 Tip The handle moves only after you release the mouse button, not while you drag it. 

 The letters at the sides of the WordArt object stretch so that the triangle effect is 

less exaggerated. 
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 11. Click away from the object to release the selection and see the results. 

CLOSE the publication without saving your changes.

Working with Graphics
Publisher 2007 provides access to hundreds of professionally designed pieces of clip 
art—license-free graphics that often take the form of cartoons, sketches, or symbolic 

images, but can also include photographs, audio and video clips, and more sophisti-

cated artwork. In a publication, you can use clip art to illustrate a point you are making 

or as eye-pleasing accompaniments to text. For example, you might insert an icon of 

an envelope to draw attention to an e-mail address, or a picture of mountains to set a 

“back to nature” tone. 

To search for a clip art image, you display the Clip Art task pane and enter a keyword. You 

can search a specifi c Microsoft Clip Organizer collection, search for specifi c media types, 

such as photographs, and search for images on the Microsoft Offi ce Online Web site. 

See Also For information about creating collections of images, see the sidebar titled “Clip 
Organizer,” later in this chapter.

You can add illustrations created and saved in other programs or scanned photographs 

and illustrations to your publications. We refer to these types of graphics as pictures. 
Like clip art, pictures can be used to make your publications more attractive and visually 

interesting. However, pictures can also convey information in a way that words cannot. 

For example, you might display photographs of your company’s products in a catalog or 

brochure. 



Graphic Formats
You can use a variety of graphic fi le formats in Publisher publications. Here are 

some of the more common formats: 

O BMP (bitmap). Stores graphics as a series of dots, or pixels. The different 

types of BMP refl ect the number of bits per pixel needed to store information 

about the graphic—the greater the number of colors, the greater the number 

of bits needed. 

O GIF (Graphics Interchange Format). Common for images that appear on 

Web pages because they can be compressed with no loss of information and 

groups of them can be animated. GIFs work well for line drawings, pictures 

with blocks of solid color, and pictures with sharp boundaries between colors. 

GIFs store at most 8 bits per pixel, so they are limited to 256 colors. 

O JPEG (Joint Photographic Experts Group). A compressed format that 

works well for complex graphics such as scanned photographs. Some infor-

mation is lost in the compression process, but often the loss is imperceptible 

to the human eye. Color JPEG images store 24 bits per pixel, so they are ca-

pable of displaying more than 16 million colors. Grayscale JPEG images store 

8 bits per pixel. 

O PNG (Portable Network Graphic). Has the advantages of the GIF format 

but can store colors with 8, 24, or 48 bits per pixel and grayscales with 1, 2, 4, 

8, or 16 bits per pixel. A PNG fi le can also specify whether each pixel blends 

with its background color and can contain color correction information so 

that images look accurate on a broad range of display devices. Graphics saved 

in this format are smaller, so the size of the publication fi le is also smaller. 

O TIFF (Tag Image File Format). Stores compressed images with a fl exible 

number of bits per pixel. Using tags, a single multi-page TIFF fi le can store 

several images, along with related information such as type of compression, 

orientation, and so on. 

O WMF (Windows Metafi le). A 16-bit vector graphic format commonly used 

in the 1990s but largely eclipsed by more modern formats suited to both 

print and Web applications. 

Graphic Formats
You can use a variety of graphic fi le formats in Publisher publications. Here are You can use a variety of graphic fi le formats in Publisher publications. Here are 

some of the more common formats:some of the more common formats:

O BMP (bitmap).BMP (bitmap). Stores graphics as a series of dots, or pixels. The different Stores graphics as a series of dots, or pixels. The different 

types of BMP refl ect the number of bits per pixel needed to store informationtypes of BMP refl ect the number of bits per pixel needed to store information

about the graphic—the greater the number of colors, the greater the number about the graphic—the greater the number of colors, the greater the number 

of bits needed.of bits needed.

O GIF (Graphics Interchange Format).GIF (Graphics Interchange Format). Common for images that appear on Common for images that appear on 

Web pages because they can be compressed with no loss of information and Web pages because they can be compressed with no loss of information and 

groups of them can be animated. GIFs work well for line drawings, pictures groups of them can be animated. GIFs work well for line drawings, pictures 

with blocks of solid color, and pictures with sharp boundaries between colors.with blocks of solid color, and pictures with sharp boundaries between colors.

GIFs store at most 8 bits per pixel, so they are limited to 256 colors.GIFs store at most 8 bits per pixel, so they are limited to 256 colors.

O JPEG (Joint Photographic Experts Group).JPEG (Joint Photographic Experts Group). A compressed format that  A compressed format that 

works well for complex graphics such as scanned photographs. Some infor-works well for complex graphics such as scanned photographs. Some infor-

mation is lost in the compression process, but often the loss is imperceptiblemation is lost in the compression process, but often the loss is imperceptible

to the human eye. Color JPEG images store 24 bits per pixel, so they are ca-to the human eye. Color JPEG images store 24 bits per pixel, so they are ca-

pable of displaying more than 16 million colors. Grayscale JPEG images storepable of displaying more than 16 million colors. Grayscale JPEG images store

8 bits per pixel.8 bits per pixel.

O PNG (Portable Network Graphic).PNG (Portable Network Graphic). Has the advantages of the GIF format Has the advantages of the GIF format

but can store colors with 8, 24, or 48 bits per pixel and grayscales with 1, 2, 4, but can store colors with 8, 24, or 48 bits per pixel and grayscales with 1, 2, 4, 

8, or 16 bits per pixel. A PNG fi le can also specify whether each pixel blends 8, or 16 bits per pixel. A PNG fi le can also specify whether each pixel blends 

with its background color and can contain color correction information so with its background color and can contain color correction information so 

that images look accurate on a broad range of display devices. Graphics savedthat images look accurate on a broad range of display devices. Graphics saved

in this format are smaller, so the size of the publication fi le is also smaller.in this format are smaller, so the size of the publication fi le is also smaller.

O TIFF (Tag Image File Format).TIFF (Tag Image File Format). Stores compressed images with a fl exible Stores compressed images with a fl exible 

number of bits per pixel. Using tags, a single multi-page TIFF fi le can storenumber of bits per pixel. Using tags, a single multi-page TIFF fi le can store

several images, along with related information such as type of compression,several images, along with related information such as type of compression,

orientation, and so on.orientation, and so on.

O WMF (Windows Metafi le).WMF (Windows Metafi le). A 16-bit vector graphic format commonly used  A 16-bit vector graphic format commonly used 

in the 1990s but largely eclipsed by more modern formats suited to both in the 1990s but largely eclipsed by more modern formats suited to both 

print and Web applications.print and Web applications.
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Clip Organizer
To make clip art images and other media available no matter where they are actu-

ally stored, you can catalog them in the Microsoft Clip Organizer. With this useful 

tool, you can arrange clip art images, pictures, audio clips, and video clips that are 

stored in different locations. You can organize media installed with Microsoft Offi ce 

programs, downloaded from the Web, or obtained from other sources into exist-

ing or new collections. You can access these collections from within any Microsoft 

Offi ce program. 

 To add an image to the Clip Organizer: 

  1. At the bottom of the Clip Art task pane, click the Organize clips link. 

 The Favorites - Microsoft Clip Organizer window opens. 

  2. In the Collection List pane, under My Collections, click the Favorites folder. 

  3. On the window’s File menu, point to Add Clips to Organizer, and then click 

On My Own. 

 The Favorites - Add Clips To Organizer dialog box opens. 

  4. Navigate to and select the fi le you want to add to the Favorites collection, 

and then click the Add button. 

 To place images in a collection other than the currently selected one, click the 

Add To button, and then in the Import To Collection dialog box, select or cre-

ate the collection you want. 

 To add keywords to an image: 

  1. In the Favorites – Microsoft Clip Organizer window, point to the image, click 

the arrow that appears, and then click Edit Keywords. 

 The Keywords dialog box opens. 

  2. In the Keyword box, type the word or words that you want to associate with 

this fi le (separating words and phrases with commas), and then click Add. 

 Your keywords are added to the Keywords For Current Clip list, which already 

contains any previously associated keywords. 

  3. Click OK to close the Keywords dialog box. 

 To delete a clip art image from the Clip Organizer, in the Microsoft Clip Organizer 

window, point to the image, click the arrow that appears, click Delete From Clip 

Organizer, and then click OK to confi rm the deletion. 

Clip Organizer
To make clip art images and other media available no matter where they are actu-To make clip art images and other media available no matter where they are actu-

ally stored, you can catalog them in the ally stored, you can catalog them in the Microsoft Clip Organizer. With this useful . With this useful rrr
tool, you can arrange clip art images, pictures, audio clips, and video clips that aretool, you can arrange clip art images, pictures, audio clips, and video clips that are

stored in different locations. You can organize media installed with Microsoft Offi ce stored in different locations. You can organize media installed with Microsoft Offi ce 

programs, downloaded from the Web, or obtained from other sources into exist-programs, downloaded from the Web, or obtained from other sources into exist-

ing or new collections. You can access these collections from within any Microsoft ing or new collections. You can access these collections from within any Microsoft 

Offi ce program.Offi ce program.

To add an image to the Clip Organizer:To add an image to the Clip Organizer:

1. 1. At the bottom of theAt the bottom of the Clip ArtClip Art task pane, click the task pane, click the Organize clipsOrganize clips link. link.

The Favorites - Microsoft Clip Organizer window opens.The Favorites - Microsoft Clip Organizer window opens.

2. 2. In theIn the Collection ListCollection List pane, under pane, under My CollectionsMy Collections, click the, click the FavoritesFavorites folder.folder.

3. 3. On the window’s On the window’s FileFile menu, point to menu, point to Add Clips to OrganizerAdd Clips to Organizer, and then click, and then clickrrrr
On My OwnOn My Own..

The Favorites - Add Clips To Organizer dialog box opens.The Favorites - Add Clips To Organizer dialog box opens.

4. 4. Navigate to and select the fi le you want to add to the Favorites collection, Navigate to and select the fi le you want to add to the Favorites collection, 

and then click theand then click the AddAdd button. button.

To place images in a collection other than the currently selected one, click the To place images in a collection other than the currently selected one, click the 

Add To button, and then in the Import To Collection dialog box, select or cre-Add To button, and then in the Import To Collection dialog box, select or cre-

ate the collection you want.ate the collection you want.

To add keywords to an image:To add keywords to an image:

1. 1. In theIn the Favorites – Microsoft Clip OrganizerFavorites – Microsoft Clip Organizer window, point to the image, click window, point to the image, click 

the arrow that appears, and then click the arrow that appears, and then click Edit KeywordsEdit Keywords..

The Keywords dialog box opens.The Keywords dialog box opens.

2. 2. In theIn the KeywordKeyword box, type the word or words that you want to associate with box, type the word or words that you want to associate with 

this fi le (separating words and phrases with commas), and then click this fi le (separating words and phrases with commas), and then click AddAdd..

Your keywords are added to the Keywords For Current Clip list, which already Your keywords are added to the Keywords For Current Clip list, which already 

contains any previously associated keywords.contains any previously associated keywords.

3. 3. Click Click OKOK to close theto close theKK KeywordsKeywords dialog box.dialog box.

To delete a clip art image from the Clip Organizer, in the Microsoft Clip Organizer To delete a clip art image from the Clip Organizer, in the Microsoft Clip Organizer 

window, point to the image, click the arrow that appears, click Delete From Clip window, point to the image, click the arrow that appears, click Delete From Clip 

Organizer, and then click OK to confi rm the deletion.Organizer, and then click OK to confi rm the deletion.



Positioning and Sizing a Graphic 
After you insert a graphic into a publication, you can move and size it just as you can any 

other object. You can also do the following: 

O Rotate the graphic to any angle. 

O Crop away the parts of the graphic that you don’t want to show in the publication. 

(The graphic itself is not altered—parts of it are simply not shown.) 

O Compress the image to minimize the fi le size. 

 Tip The fi le size of a publication that contains graphics can become quite large. You 

can shrink the size of a graphic fi le (without affecting the displayed graphic) by using the 

Compress Pictures feature. Depending on the resolution setting, you might lose some 

visual quality when you compress a picture. You choose the resolution you want for the 

pictures based on where or how the presentation will be viewed—for example, on the Web 

or printed. You can also set other options, such as deleting cropped areas of a picture, to 

achieve the best balance between quality and fi le size. This is especially important when 

you intend to distribute a publication electronically, because the fi le size affects how long 

it takes to transmit or download. 

Modifying the Appearance of a Graphic 
When a graphic object is selected, Publisher displays the Picture toolbar. You can use 

the buttons on this toolbar to modify the appearance of the selected graphic in various 

ways, including the following: 

O Change the color. 

O Change to shades of gray (called grayscale), black and white, or muted shades of its 

original colors (called washout). 

O Adjust the contrast. 

O Adjust the brightness. 

O Change the color and style of the border. 

O Make parts of the graphic transparent. 

And if you decide you don’t like the changes you have made to a graphic, you can restore 

the original settings by clicking the Reset Picture button. 

In this exercise, you will insert and modify a clip art image, and then insert and crop a 

picture. Then you will decrease the fi le sizes of the two graphics by compressing them. 
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USE the Birthday at the Ritz picture fi le. This practice fi le is located in the Documents\
Microsoft Press\SBS_Publisher2007\VisualInterest folder.

OPEN a blank publication.

 1. On the Objects toolbar, click the Picture Frame button, and then click Clip Art. 

 Tip If you are designing the layout of a publication and know you will want to 

insert some sort of graphic later, you can click Empty Picture Frame to insert a 

graphic placeholder. 

The Clip Art task pane opens. 

 2. In the Search for box at the top of the task pane, type birthday. Click the Search in 

arrow, and select the Everywhere check box. Then click Go. 

Thumbnails of clip art, photographs, movies, and sounds with the keyword birthday 

appear in the task pane.

USE the the Birthday at the RitzBirthday at the Ritz picture fi le. This practice fi le is located in the picture fi le. This practice fi le is located in thezz Documents\Documents\
Microsoft Press\SBS_Publisher2007\VisualInterestMicrosoft Press\SBS_Publisher2007\VisualInterest folder.folder.tt

OPEN a blank publication.a blank publication.

Picture FramePicture Frame



 Troubleshooting Images sourced from Microsoft Offi ce Online are indicated by 

an Internet icon in the lower-left corner of the image thumbnail. If you do not have 

an active Internet connection, you might not see all the clip art images shown here. 

In that case, pick any clip art image to follow the steps in this exercise. 

 3. Scroll the thumbnail list box, and point to any stylized drawing of a cake with 

candles. 

A ScreenTip displays the beginning of the list of keywords associated with the image, 

its dimensions and fi le size, and its format. 

See Also For information about common graphic formats, see the sidebar titled 
“Graphic Formats,” earlier in this chapter.

 4. Toward the bottom of the list box, click one of the one-color cake silhouettes. 

Publisher inserts the image into the publication and displays the Picture toolbar. 

 5. With the clip art image still selected, on the Picture toolbar, click the Format 
Picture button. 

The Format Picture dialog box opens. 

Troubleshooting Images sourced from Microsoft Offi ce Online are indicated byImages sourced from Microsoft Offi ce Online are indicated by

an Internet icon in the lower-left corner of the image thumbnail. If you do not have an Internet icon in the lower-left corner of the image thumbnail. If you do not have 

an active Internet connection, you might not see all the clip art images shown here. an active Internet connection, you might not see all the clip art images shown here. 

In that case, pick any clip art image to follow the steps in this exercise.In that case, pick any clip art image to follow the steps in this exercise.

Format PictureFormat Picture
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 Important The following formatting choices apply to the cake image we selected. If 

you selected a different image, you might want to choose different formatting options. 

 6. Under Image control on the Picture tab, click the Recolor button. 

Troubleshooting If you chose a more-complex graphic than the one shown in the 

example, you might not be able to recolor it. 

 7. In the Recolor Picture dialog box, click the Color arrow, and in the default color 

palette, click the Purple box. Then click OK. 

 8. In the Format Picture dialog box, change the Brightness setting to 25% and the 

Contrast setting to 75%. 

 9. Click the Colors and Lines tab, and under Fill, click the Color arrow, and click the 

Gray box. Then under Line, click the Color arrow, and click the Purple box. 

 10. Click the Size tab, and under Scale, change the Height setting to 75%. Then click 

the Width box. 

Troubleshooting If you chose a more-complex graphic than the one shown in the If you chose a more-complex graphic than the one shown in the 

example, you might not be able to recolor it.example, you might not be able to recolor it.



The Width setting changes to 75% because the aspect ratio of the graphic is 

locked. You can change the proportions of the image by clearing the Lock Aspect 

Ratio check box. 

 11. Click the Layout tab, and under Position on page, change the Horizontal setting 

to 1” and the Vertical setting to 1”. Then click OK. 

The small graphic jumps to the upper-left corner of the page, displaying its new 

purple and gray color scheme. (If necessary, move the toolbar to see the image.) 

 12. Click a blank area of the page to release the selection, and then close the Clip Art 
task pane.

 13. On the Objects toolbar, click the Picture Frame button, and then click Picture 
from File. 

Troubleshooting If you don’t release the selection before clicking the button, the 

new picture will replace the clip art image. 

 14. Move the pointer over the page below the clip art image, and drag to create a 

frame about 4 inches square. (Use the rulers or the size indicator on the status bar 

to guide you.) 

When you release the mouse button, Publisher displays the Insert Picture dialog box.  

See Also For information about how to move around in dialog boxes such as this one, see 
“Saving and Closing Publications” in Chapter 1, “Getting Started with Publisher 2007.”

 15. If the contents of the VisualInterest folder are not displayed, navigate to the 

Documents\Microsoft Press\SBS_Publisher2007\VisualInterest folder, and double-

click the Birthday at the Ritz picture. 

Publisher inserts the picture in the frame you drew on the page and displays the 

Picture toolbar. 

Troubleshooting If you don’t release the selection before clicking the button, the If you don’t release the selection before clicking the button, the 

new picture will replace the clip art image.new picture will replace the clip art image.
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 16. If necessary, move the Picture toolbar out of the way. Then drag the lower-right han-

dle of the frame down and to the right until the picture fi lls the width of the page. 

 17. With the picture still selected, on the Picture toolbar, click the Crop button. 

Cropping handles appear in the corners and on the sides of the picture. 

Cropping handles

CropCrop



 18. Drag the top cropping handle down to the top of the candle fl ames. Then drag the 

left and right cropping handles to tightly focus the picture on the plate and the 

little cake. 

 19. Click the Crop button to hide the cropping handles. 

 20. With the picture still selected, on the Picture toolbar, click the Line/Border Style 

button, and in the list, click the 3 pt line. Then click a blank area of the page to see 

the results. 

  21. Click the picture, and then on the Picture toolbar, click the Compress Pictures 

button. 

 The Compress Pictures dialog box opens. 

Line/Border StyleLine/Border Style

Compress 
Pictures

Compress 
Pictures
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Notice the current size of the image fi les and the estimated size after compression 

using the default settings. Unless you select the Apply To Selected Pictures Only 

check box, Publisher will compress all the pictures in the publication, not only the 

selected picture. 

 22. Under Compression options, leave all the check boxes selected. Under Target 
Output, click Web. 

Notice that the estimated size after compression using the new settings is much 

smaller. The resolution for displaying graphics on the Web is much lower than the 

resolution for printing. 

 23. Click Compress. Then click Yes to apply picture optimization. 

Publisher compresses the pictures and deletes the cropped parts of the picture. If you 

were to save the fi le now, the compressed pictures would result in a smaller fi le size. 

CLOSE the publication without saving your changes.

Working with Shapes
Publisher provides tools for creating several types of shapes, including lines, arrows, 

ovals, rectangles, stars, banners, and many more. With a little imagination, you will 

discover countless ways to create drawings by combining shapes. 

To create a shape in Publisher, you click a shape button on the Objects toolbar and 

then drag the crosshair pointer across the page to defi ne the size of the shape. After 

you draw the shape, it is surrounded by a set of handles, indicating that it is selected. 

(You can select a shape at any time by simply clicking it.) 

Tip To draw a circle or square, click the Oval or Rectangle shape, and hold down the Shift 

key while you drag. 

You can easily add text to a shape. Simply select the shape by clicking it, and start typ-

ing. You can then format the text by clicking buttons on the Formatting toolbar or by 

making selections in the Font dialog box. 



Manipulating a Shape
To move a shape from one location to another on the same page, you simply point to 

the shape, and when the pointer becomes a four-headed arrow, drag the shape to its 

new location, using the coordinates shown on the status bar to position it precisely. (You 

can create a copy of a selected shape by dragging it while holding down the Ctrl key.) 

You can also reposition a shape by changing settings on the Layout tab of the Format 

AutoShape dialog box. 

Tip If you hold down the Shift key while moving a shape, you can move it only horizontally 

or vertically in a straight line. 

The handles around a selected shape serve the same sizing and rotating purposes as 

those around any other object. You can use the dimensions shown on the status bar 

to adjust the size precisely, or you can set the size of the shape on the Size tab of the 

Format AutoShape dialog box. You can rotate it by using the Rotate Or Flip command 

on the Arrange menu. 

After drawing a shape, you can fi ll it with color by using the settings on the Colors And 

Lines tab of the Format AutoShape dialog box or by selecting a color from the palette 

displayed when you click the Fill Color arrow on the Formatting toolbar. You can change 

the color and width of the border on the Color And Lines tab of the Format AutoShape 

dialog box, or change only its width by clicking the Line/Border Style button on the 

Formatting toolbar.

 Tip Having made changes to one shape, you can easily apply the same attributes to another 

shape by clicking the shape that has the desired attributes, clicking the Format Painter button 

on the Standard toolbar, and then clicking the shape to which you want to copy the attributes.  

If you want to apply the attributes of a shape to all future shapes in the same publication 

(for example, if you want all shapes to be red), double-click the shape, and on the Colors 

And Lines tab of the Format AutoShape dialog box, select the Apply Settings To New 

AutoShapes check box. 

Connecting and Grouping Shapes
To show a relationship between two shapes, you can connect them with a line by joining 

special handles called connection points. Moving a connected shape also moves the line, 

maintaining the relationship between the connected shapes. 
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When you create a drawing composed of multiple shapes, you can group them so that 

you can edit, copy, and move them as a unit. You can select an individual shape within the 

group and change its attributes—for example, its color or the weight of its border. You 

can ungroup the grouped shapes at any time and regroup them after making changes. 

In this exercise, you will draw several shapes of the same color. Then you will connect 

two shapes and format the connection line. Finally, you will group and ungroup the 

shapes. There is no practice fi le for this exercise. 

OPEN a blank publication, and then close the Format Publication task pane.

 1. On the Objects toolbar, click the AutoShapes button, point to Basic Shapes, and 

then click the third shape in the second row (Isosceles Triangle). 

 2. Move the pointer over the page, and starting about 1 inch below the top margin 

guide, drag to draw a triangle about 1 inch tall and 1/2 inch wide. 

 3. On the Arrange menu, point to Rotate or Flip, and then click Flip Vertical. 

The triangle is now upside down. 

 4. Double-click the shape, and on the Colors and Lines tab of the Format AutoShape 

dialog box, change the Color setting under Fill to Orange. Then select the Apply 
settings to new AutoShapes check box, and click OK. 

 5. On the Objects toolbar, click the Oval button, hold down the G key, and drag a 

circle above the triangle with a diameter slightly smaller than the triangle’s side. 

When you release the mouse button, Publisher fi lls the circle with the orange color 

you specifi ed for all shapes in this publication. 

Tip If you click a shape button on the Objects toolbar and then change your mind 

about drawing the shape, you can release the shape by pressing the Esc key. 

OPEN a blank publication, and then close the Format Publication task pane.a blank publication, and then close the Format Publication task pane.

AutoShapesAutoShapes

OvalOval



 6. On the Objects toolbar, click the Oval button, and drag an oval about 1.5 inches 

wide to the right of the circle. 

 7. On the Objects toolbar, click the AutoShapes button, point to Connectors, and 

then click the fi rst shape in the third row (Curved Connector). 

 8. Point to the triangle, and when blue handles appear, drag a line from the upper-

right handle of the triangle to the bottom handle of the oval. 

Publisher joins the two shapes with a curved connecting line. Red handles appear 

at each end of the line, indicating that the shapes are connected. A yellow diamond-

shaped handle in the center of the line provides a means to adjust the curve of the 

line.

 Troubleshooting The yellow handle appears only if the line is long enough to 

support it. If you do not see the yellow handle, drag the oval slightly up or to the 

right to lengthen the connector line. 

 9. Double-click the line (not its handle), and under Line on the Colors and Lines tab 

of the Format AutoShape dialog box, change the Color to Orange and the Weight 
to 6 pt. Then click OK. 

Troubleshooting The yellow handle appears only if the line is long enough to The yellow handle appears only if the line is long enough to 

support it. If you do not see the yellow handle, drag the oval slightly up or to thesupport it. If you do not see the yellow handle, drag the oval slightly up or to the

right to lengthen the connector line.right to lengthen the connector line.
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 10. Click the oval, and move it to the left, close to the circle. 

Publisher adjusts the length and curve of the connecting line. 

 11. Click the line, and drag the yellow diamond handle down to create a smooth curve. 

Then click a blank area of the page to see the results. 

 12. Select the four shapes by holding down the G key as you click each one in turn. 

Notice that each shape has its own set of handles. 

 13. On the Arrange menu, click Group. 

Publisher groups the shapes together with only one set of handles around the 

edge of the entire group. When the group is selected, the Ungroup Objects 

button appears below it so that you can ungroup the shapes at any time. 

 14. Point to any shape in the group, and when the pointer changes to a four-headed 

arrow, drag the grouped object to the upper-left corner of the page until the co-

ordinates are 1.000, 1.000 in. 

The entire group moves. 

 15. Click away from the individual shape to release the selection, and then click the 

grouped shape to select it. Point to the lower-right handle and drag up and to the 

left until the dimensions of the grouped object are 1.500 x 1.000 in. 



 16. Click a blank area of the page to see the results. 

 17. Click the grouped shape to select it, and then click the Ungroup Objects button. 

Publisher ungroups the object into individual shapes, which are all selected, and 

displays the Group Objects button. You can now adjust the size and position of 

individual shapes. 

 18. Click the Group Objects button. 

Publisher regroups the shapes. Now suppose you want to add a shape to the 

group. 

 19. On the Objects toolbar, click the AutoShape button, point to Basic Shapes, and 

then click the third shape in the fi rst row (Trapezoid). 

 20. Draw a tiny “cup” on top of the oval “tray,” hold down the G key, click any of the 

other shapes, and then click the Group button. 

 Publisher adds the cup shape to the group. 

CLOSE the publication without saving your changes.

Ungroup ObjectsUngroup Objects

Group ObjectsGroup Objects
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Working with Pre-Designed Visual Elements
Publisher excels at helping you create visually exciting publications. One of the ways it 

provides assistance is by offering hundreds of ready-made visual elements that you can 

insert in a publication with a couple of clicks. 

To simplify the use of these visual elements, Publisher 2007 organizes them in categories 

in the Design Gallery. Many of the elements have a common design and color scheme to 

give your publications a consistent look. When you are more familiar with color schemes 

and themes, you will be able to customize the colors of these elements, but for now, we 

will show you how to use the default Design Gallery elements to add professional touches 

to your publications. 

See Also For information about applying a different color scheme and using custom colors, 
see “Creating Folded Cards” in Chapter 3, “Creating Colorful Cards and Calendars.”

You cannot add a customized element to the Design Gallery, even if you originally in-

serted it in your publication from that gallery. If you want to reuse a customized Design 

Gallery element, or any other object, you can copy and paste it between publications or 

you can add it to the Content Library. 

See Also For information about storing objects for use in other publications, see 
“Adding Items to the Content Library” in Chapter 4, “Marketing Your Product, Service, or 
Organization.”

In this exercise, you will insert ready-made elements from three categories of the Design 

Gallery into a publication. There is no practice fi le for this exercise. 

OPEN a blank publication, and then close the Format Publication task pane.

 1. On the Objects toolbar, click the Design Gallery Object button. 

The Design Gallery opens. The left pane displays a list of categories. Clicking a 

category in the left pane displays the available Design Gallery objects in the 

right pane. 

Notice that the objects available in the Accent Box category are all depicted in the 

same color scheme. 

OPEN a blank publication, and then close the Format Publication task pane.a blank publication, and then close the Format Publication task pane.

Design Gallery 
Object

Design Gallery 
Object



 2. In the left pane, click Borders. Then in the right pane, double-click Stacked 
Corners. 

Publisher inserts an asymmetrical border around the perimeter of the page. 

 3. With the border selected, press the O key and the N key repeatedly until the 

blue margin guides are approximately centered within the border. 

The border consists of sets of overlapping rectangles. You can move the entire 

border because all of its components are grouped to form one object that can be 

treated as a single unit. 

See Also For information about grouping objects, see “Connecting and Grouping 
Shapes,” earlier in this chapter.
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 4. Display the Design Gallery again, click Dots in the left pane, and then double-click 

Diamond in the right pane. 

 5. With the row of dots selected, point to one of the corner handles on the left, and 

drag until the row of diamonds extends to the blue margin guide on the left. Then 

repeat this step to extend the row to the blue margin guide on the right. 

 6. Display the Design Gallery, and in the left pane, click Coupons. 

The Design Gallery displays the three available coupon designs, along with options 

for customizing them. 

 7. In the middle pane, click Top Oval. In the Options pane, under Border, click Basic 
dots. Then click Insert Object. 

 8. Drag the coupon to the area below the row of diamonds. Then use the corner 

handles to enlarge the coupon until it fi lls the available space. 

By inserting the three ready-made objects from the Design Gallery, you have 

created this basic fl yer: 



You can customize the color and appearance of the placeholder text and graphic 

elements as you want. 

CLOSE the publication without saving your changes, and if you are not continuing directly 

on to the next chapter, quit Publisher.

Key Points
O Creating and manipulating visual elements is a basic Publisher skill that you will use 

when working in most publications. 

O You can reposition most elements by dragging them, and you can resize elements 

by dragging their sizing handles. 

O You can group elements together to manipulate them as a single unit. 

O Before you spend time creating graphics, check for publicly available clip art and 

ready-made Design Gallery elements. 
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Chapter at a Glance  5 5 Creating Text-Based  Creating Text-Based 
  Publications  Publications
In this chapter, you will learn to:

� Plan longer publications.

� Create newsletters.

� Organize content.

� Edit and proof content.

Most publications contain text, even if it is just a heading or two. However, some types of 

publications rely mostly on text to convey information, with graphics and other elements 

playing only a supporting role. Text-based publications that are more than a couple of 

pages in length, especially those containing multiple stories, pose unique challenges, such 

as how to fl ow text logically across multiple pages, how to juggle pages containing differ-

ent kinds of content, and how to effi ciently edit the text and ensure that it is error-free. 

In this chapter, you will fi rst review design concepts that pertain to longer publications. 

Then you will create a multi-page newsletter; size text to fi t the available space, and add 

pages. You will continue stories by linking and unlinking text boxes, insert and remove 

Continued notices, move and delete pages, and format text in columns. Finally, you will 

edit a publication in Microsoft Offi ce Word and correct its spelling in Microsoft Offi ce 

Publisher 2007. 

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxvii–xli.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xvii for more information. 
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 Troubleshooting Graphics and operating system–related instructions in this book 

refl ect the Windows Vista user interface. If your computer is running Windows XP 

and you experience trouble following the instructions as written, please refer to the 

“Information for Readers Running Windows XP” section at the beginning of this book. 

Planning Longer Publications
Most of the publications we’ve created in this book have been from one to four pages 

long, which is the length specifi ed by most Publisher design and layout templates. 

However, you can create longer publications, either by inserting pages in a template-

based publication or by creating a publication from scratch. You can create an 8-page 

menu, a 12-page newsletter, a 100-page report, a 1000-page book—the possibilities 

are limited only by your imagination and by printing practicalities. 

When producing a publication that will contain a lot of content, you can save time by 

planning its design before you start creating it. Many of the decisions you will need to 

make for printed publications are based on the quantity you need to produce, the quality 

you want to achieve, and the amount of money you want to invest. For a printed publica-

tion, you will need to consider the following: 

O Color. Will the printed publication be four-color (photographic quality), two-color 

(usually black plus an accent color), or monochromatic? Color is more expensive, 

regardless of the production method. 

O Physical size and format. Approximately how many pages will the publication in-

clude? Will the format fi t a standard paper size or require trimming? Do you plan to 

distribute the publication in a stapled, full-page format; in a loose-leaf ring binder; 

as a folded and stapled booklet; or as a bound document? Some binding methods 

can support up to a maximum number of pages; if you produce a 1000-page train-

ing manual, for example, stapling and tape binding are not viable options. 

O Production method. How many copies of the publication will you produce? Will 

you print only one copy of the publication for reproduction, or one copy for each 

recipient? Will you print the publication on your own printer, at a copy shop, or 

through a professional printing service? 

Troubleshooting Graphics and operating system–related instructions in this book Graphics and operating system–related instructions in this book 

refl ect the Windows Vista user interface. If your computer is running Windows XPrefl ect the Windows Vista user interface. If your computer is running Windows XP

and you experience trouble following the instructions as written, please refer to the and you experience trouble following the instructions as written, please refer to the 

“Information for Readers Running Windows XP” section at the beginning of this book.“Information for Readers Running Windows XP” section at the beginning of this book.



Other design considerations apply to all types of publications, whether intended for 

printing or for electronic distribution. For any publication, you will need to consider the 

following: 

O Basic layout. Where will you start your publication design? Can you use an existing 

Publisher template? If you will create similar publications in the future, do you need 

to design a custom template? For a custom template, will it be easier to start with a 

Publisher design or layout template and then add and remove elements as neces-

sary? Or should you start from a blank page, insert the specifi c design elements 

you need, and then save the publication as a template? 

Important You don't have to create a template for a one-time publication. 

However, saving the publication as a template makes it available for use in the event 

that you create a second publication of the same type or of a similar type. It also 

makes it easier to start over if you encounter a problem with your fi rst attempt. 

O Text design. Can you use an existing font scheme and color scheme? Or do you 

need to create custom schemes? The font and font size you select can have a sig-

nifi cant impact on the length of your publication. 

See Also For more information about the impact of fonts on publication length, see 
“Solving Organization Problems,” later in this chapter.

O Page types. Will your publication include multiple page types, such as a cover 

page, a page for contributions from regular columnists or readers, an order form, 

and so on? If this is a periodic publication, you will want to place repeating features 

such as a letter from the editor or a contact list in the same location in each issue 

so that readers know where to fi nd it. 

O Static information. Will each issue of a periodic publication include static informa-

tion, such as the title, return address, and logo, in the same places? You can save 

time by entering that information before saving the publication as a template. 

If you do need to create a custom design, page layouts, a font scheme, or a color 

scheme, do this fi rst so that when you fl ow content into the publication, it immediately 

appears in its fi nal format. By laying the groundwork, you can quickly identify and 

handle content issues as they arise. 

 Tip To save a publication as a template, click Save As on the File menu, and then in 

the Save As Type list, click Publisher Template. Publisher saves all the content along 

with the design, layout, font scheme, and color scheme. 
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Non-Standard Sizes
Publisher comes with templates for a wide variety of publications. Most are appro-

priate for use by businesses and community organizations, many are useful for 

personal or family occasions, and a few are just for fun. Among the latter are the 

paper-folding templates from which you can create paper airplanes or origami 

models. (The airplane templates even include optional aerodynamic indicators.) 

Most of the templates we work with in this book are designed for printing on 

standard-sized paper, but Publisher also provides for the non-standard publica-

tions you might need to complete your branding portfolio. You can create large 

items, such as banners and signs, and small items, such as advertisements and gift 

certifi cates, using the same resources and techniques you would for any other 

publication. Although these publications are not primarily text-based, they can 

present copyfi tting challenges that you will be better equipped to meet after 

reading this chapter. 

Creating Newsletters
A newsletter is a periodic publication containing information of interest to a specifi c 

group—for example, employees of a company or members of a club or other organiza-

tion. Newsletter recipients are frequently subscribers you track in a mailing list, rather 

than people you don’t know. Depending on the size of your subscription base and the 

amount and frequency of information in each newsletter, you might choose to deliver 

the content in a traditional printed format or in an electronic format, such as on a Web 

site or by e-mail. 

See Also For information about electronic publications, see Chapter 6, “Communicating Your 
Message Online.”

Publisher 2007 includes over 60 preformatted newsletter designs. When creating a 

newsletter based on one of these templates, you can choose a one-page spread, appro-

priate for printing on separate sheets of paper, or a two-page spread, appropriate for a 

booklet-style publication. If you will distribute the newsletter by mail, you can designate 

a portion of the back page for mailing information. This area, which is designed to be 

visible when you fold the publication, includes areas for information about your organi-

zation, postage, and recipient details. To enter the recipient details, you can hand-write 

names and addresses, affi x mailing labels, or merge the newsletter with a recipient list to 

create an individual publication for each recipient. 

Non-Standard Sizes
Publisher comes with templates for a wide variety of publications. Most are appro-Publisher comes with templates for a wide variety of publications. Most are appro-

priate for use by businesses and community organizations, many are useful forpriate for use by businesses and community organizations, many are useful for

personal or family occasions, and a few are just for fun. Among the latter are the personal or family occasions, and a few are just for fun. Among the latter are the 

paper-folding templates from which you can create paper airplanes or origamipaper-folding templates from which you can create paper airplanes or origami

models. (The airplane templates even include optional aerodynamic indicators.)models. (The airplane templates even include optional aerodynamic indicators.)

Most of the templates we work with in this book are designed for printing onMost of the templates we work with in this book are designed for printing on

standard-sized paper, but Publisher also provides for the non-standard publica-standard-sized paper, but Publisher also provides for the non-standard publica-

tions you might need to complete your branding portfolio. You can create largetions you might need to complete your branding portfolio. You can create large

items, such as banners and signs, and small items, such as advertisements and giftitems, such as banners and signs, and small items, such as advertisements and gift

certifi cates, using the same resources and techniques you would for any othercertifi cates, using the same resources and techniques you would for any other

publication. Although these publications are not primarily text-based, they can publication. Although these publications are not primarily text-based, they can 

present copyfi tting challenges that you will be better equipped to meet after present copyfi tting challenges that you will be better equipped to meet after 

reading this chapter.reading this chapter.



See Also For information about merging publications with a data source, see “Using Mail 
Merge” in Chapter 3, “Creating Colorful Cards and Calendars.”

Copyfi tting Text
When you customize the placeholder text in a newsletter that is based on a Publisher 

template, you will often fi nd that your text does not fi t the ready-made text boxes as 

neatly as the placeholder text did. When this happens, you can change the size of the 

text box, manually format the text to make it fi t, or have Publisher automatically copyfit 
the text. 

When you insert more text in a text box than can fi t, one of the following three things 

happens: 

O If the text box is linked to another text box, the remaining text fl ows into the next 

text box. 

O If the text box is not linked to another text box and automatic copyfi tting is turned 

off, the Text In Overfl ow icon appears, and the text size does not change. 

O If the text box is not linked to another text box and automatic copyfi tting is turned 

on, the text size decreases until the text fi ts. 

Copyfi tting is turned on by default for some text boxes created as part of a Publisher 

design or layout template, such as those intended for headings. Copyfi tting is turned off 

for general-use text boxes and those that you insert manually. You can turn copyfi tting 

on or off for a selected text box by clicking an AutoFit Text option on the Format menu 

or by clicking the Text Autofi tting option you want on the Text Box tab of the Format 

Text Box dialog box. 

Inserting Pages
Newsletters are generally text-based but frequently contain other types of information. 

Publisher provides fi ve standard newsletter page layouts: Story, Calendar, Order Form, 

Response Form, and Sign-Up Form. You can also insert a specifi ed number of blank pages 

before or after the current page, or you can duplicate an existing page layout a specifi ed 

number of times. (This option is particularly handy if you create your own page layouts.) 

In this exercise, you will create a newsletter with a color scheme appropriate for photo-

copying. You will replace placeholder text, copyfi t the text to the text boxes in which it 

appears, and add pages to accommodate the intended newsletter content. There is no 

practice fi le for this exercise. 
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BE SURE TO start Publisher and display the Getting Started window before beginning this 

exercise.

 1. In the Publication Types list, click Newsletters. 

 2. Scroll the list in the center pane to see the available newsletter templates. Then in 

the Classic Designs category, click Banded. 

 3. Under Customize in the right pane, set the Color scheme to Black & Gray and the 

Font scheme to Virtual. 

 4. Under Options, set the Page size to One-page spread, and select the Include 
customer address check box. Then click Create. 

 Publisher creates a four-page newsletter with all design elements, other than 

placeholder graphics, rendered in shades of black and gray. 

  5. Close the Format Publication task pane, and then set the Zoom level to Page Width. 

 The organization name from the active information set appears in the upper-left 

corner of this front page. Generic placeholders indicate where to insert the news-

letter title and edition-specifi c information. 

  6. Click Newsletter Title, and type Technology Times. Click Newsletter Date, and 

type April 1, 2008. Then click Volume 1, Issue 1, and type Technical support at 
your fi ngertips! 

 Troubleshooting As you type the word your, the text disappears. Keep typing, 

even though you can’t see the result. 

BE SURE TO start Publisher and display the Getting Started window before beginning thisstart Publisher and display the Getting Started window before beginning this

exercise.exercise.

Troubleshooting As you type the wordAs you type the word youryour, the text disappears. Keep typing, , the text disappears. Keep typing, rrrr
even though you can’t see the result.even though you can’t see the result.



Publisher displays the Text In Overfl ow indicator to signal that more text is in the 

selected text box than is shown. 

Text In Overflow 
indicator

 7. On the Format menu, point to AutoFit Text, and then click Shrink Text On Overfl ow. 

Publisher shrinks the text so that the entire slogan is now visible. However, it is 

very small. 

 8. Drag the right handle of the text box to the right until the text box overlaps the 

text box containing the date. Release the mouse button when the right edge of the 

selected text box is slightly to the left of the word April. Then click away from the 

box to see the results. 
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 9. On the page sorter, click the Page 2 button to display page 2. Then scroll the page 

to view the placeholder content. 

Placeholder stories within each set of linked text boxes provide useful information 

about newsletter design and content. The newsletter title you entered in step 7 

appears in a text box at the bottom of the page. 

 10. Display page 3, and scroll to the top of the page. 

The slogan you entered in step 6 is only partially visible in the text box in the upper-

left corner of the page, because the text box is not wide enough to accommodate it. 

 11. Click the text box that contains the slogan, and drag the right handle to the right so 

that the text box fi lls the available space to the left of the text box containing the 

page number. Then on the Format menu, point to AutoFit Text, and click Best Fit. 

The font size of the slogan text increases to fi t the wider text box. 

At the beginning of each story is the approximate number of words that fi ts in the 

set of linked text boxes. This estimate is based on the default font scheme for this 

template, which you changed before creating the publication. 

 12. Click anywhere in the fi rst story on page 3. 

Publisher selects the fi rst text box in the story and displays the Go To Next Text Box 

button. 

 13. Click the Go to Next Text Box button. 

Publisher selects the last text box in the story and displays the Go To Previous Text 

Box button and the Text In Overfl ow indicator. At the current font size, the place-

holder text for this story does not fi t in the space provided. 

Go to Next 
Text Box

Go to Next 
Text Box



This newsletter will contain several lengthy stories, so you need to add pages to 

accommodate them. 

 14. On the Insert menu, click Duplicate Page. 

Publisher inserts a new page 4 with the same layout as page 3. 

 15. On the Insert menu, click Page. 

The Insert Newsletter Page dialog box opens. 

 16. Click the Available page types arrow to display the types of pages you can insert. 

 17. Click each type in turn to display a preview of the page layout. 

Each page type includes at least one story area, giving you many options. 

 18. In the Available page types list, click Story. Then click More. 

The Insert Page dialog box opens. 

From this dialog box, you can insert multiple pages containing no design elements, 

one text box, or the same layout as the currently selected page. 
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 19. In the Number of new pages box, enter 3, and in the Options area, click Duplicate 
all objects on page. Then click OK. 

Publisher inserts three more identical pages. 

 20. Display page 7. On the Insert menu, click Page. In the Insert Newsletter Page dia-

log box, click Calendar in the Available page types list, and then click OK. 

Publisher inserts a page containing a calendar with a schedule of events, space for 

one story, and one graphic with a caption. The Zoom level changes to display the 

whole page.

 Troubleshooting The new calendar page uses a different font scheme than the 

one you selected when you created the newsletter. In fact, the font scheme for 

the entire publication has reverted back to the default for the template on which 

it is based to maintain consistency with the newly inserted page. Refer to step 22 

for more information. 

 21. Repeat step 20 to insert an Order Form, a Response Form, and a Sign-up Form. 

The resulting publication includes 12 pages. 

Troubleshooting The new calendar page uses a different font scheme than the The new calendar page uses a different font scheme than the 

one you selected when you created the newsletter. In fact, the font scheme forone you selected when you created the newsletter. In fact, the font scheme for

the entire publication has reverted back to the default for the template on whichthe entire publication has reverted back to the default for the template on which

it is based to maintain consistency with the newly inserted page. Refer to step 22 it is based to maintain consistency with the newly inserted page. Refer to step 22 

for more information.for more information.



  22. Display the Font Schemes section of the Format Publication task pane. 

 The Virtual font scheme appears to be selected, but in fact the publication has 

reverted to the default font scheme for the Banded newsletter template, which is 

at the top of the list. 

  23. In the font scheme list, click Virtual to reapply the font scheme to the publication. 

  24. Display page 12 to view the customer information section and other outside page 

content. 

CLOSE the publication without saving your changes.

Organizing Content
 Longer publications often include several independent stories that compete for the 

reader’s attention. Before entering content into a newsletter or other long publication, 

it is wise to decide where to place each piece of content within the overall context of 

the publication. For example, in a newsletter, important stories should start on the fi rst 

page but can continue inside the publication, most likely near the end. Some people 

think that stories that start on the right page of a two-page spread are more likely to 

be read than stories that start on the left page. In a publication that will be folded for 

mailing, place information that you defi nitely want the recipient to see on the fi rst or 

last (outside) page. 

Working with a Table of Contents
 A longer publication can often benefi t from a navigational aid such as a table of con-

tents. When you create a publication such as a newsletter, Publisher inserts a table of 

contents object on the fi rst page of the publication. You must then manually customize 

the object to refl ect the publication’s contents. 

 You can insert a table of contents object anywhere in a publication from the Design 

Gallery. You can choose from 34 designs, each color-coordinated with the current publi-

cation font scheme. If you know the name of the design or layout template the publica-

tion is based on, you might fi nd a coordinating table of contents object. 
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See Also For information about inserting objects from the Design Gallery, see “Working with 
Pre-Designed Visual Elements” in Chapter 2, “Creating Visual Interest.”

 Troubleshooting After inserting a table of contents object, you can’t change its design. 

However, changes you make to the publication font scheme or color scheme are applied to 

the table of contents object. 

Each table of contents object includes graphic elements and a table containing place-

holders for a header, article names, and page numbers. You must manually replace the 

text with your own. If you move information or add pages, Publisher will not automati-

cally update the page number in the table of contents, so it’s a good idea to insert the 

information in the table of contents after you fi nalize the page layout. 

To change the layout of a table of contents object—for example, to add or remove 

rows—right-click the table part of the object, click Format Table, and then format it as 

you would any other table. 

See Also For information about working with tables, see the sidebar titled “Presenting 
Information in Tables and Lists” in Chapter 6, “Communicating Your Message Online.”

Troubleshooting After inserting a table of contents object, you can’t change its design. After inserting a table of contents object, you can’t change its design. 

However, changes you make to the publication font scheme or color scheme are applied to However, changes you make to the publication font scheme or color scheme are applied to 

the table of contents object.the table of contents object.



Creating Sections
If the topics in a long publication fall logically into groups—for example, parts, subjects, or 

time periods—you can formally title these groups by assigning them to sections. You can 

then include only the sections—preceded by any front matter (such as an introduction) 

and followed by any back matter (such as a list of resources or a bibliography)—in the pri-

mary table of contents at the beginning of the publication, and include a list of topics in a 

secondary table of contents at the beginning of each section. 

Tip You can insert another type of section break within a paragraph to cause its text to 

continue in the next linked text box. To insert a paragraph section break, press Ctrl+Enter. 

To create a section, select the page that you want to designate as its beginning. (If your 

publication has two-page spreads, begin each section on a right page—called a recto 

page in the publishing world; the left page is called a verso page—so that the section title 

falls on the front side of the leaf and faces the reader.) Then click Section on the Insert 

menu. In the Section dialog box, select the Begin A Section With This Page check box, and 

then indicate whether you want the page to display headers and footers, and whether to 

restart the page numbering or continue from the previous section. You can choose from a 

variety of page-numbering formats and designate the beginning page number. 

 Tip You cannot automatically include the section number as part of the page-numbering 

format. As a workaround, you can manually insert it in the text box containing the page 

number. 

In some types of publications, such as reports, you might want to draw attention to the 

starting point of each section by designing a special page called a section opener. If 
the last page of the previous section ends on a recto, you can insert a blank verso page 

to force the section opener onto a recto. If you use openers, you will want to clear the 
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Show Headers And Footers On the First Page Of This Section check box before clicking 

OK to close the Section dialog box. (You will need to manually remove the header and 

footer from a preceding blank page.) 

 Tip On the page sorter, a space appears between sections. 

Moving Content
In Chapter 4, “Marketing Your Product, Service, or Organization,” we briefl y discussed 

fl owing information that doesn’t fi t in one text box into another; this is called continuing 
a story. In many types of publications, each story appears on one page, whether as a full 

page of text, multiple columns within a text box, or multiple text boxes organized to fi t 

the space. In some types of publications, however, you might need to continue a story 

elsewhere in the publication. 

For example, in a newspaper the fi rst few paragraphs of the most important story usu-

ally appear on the front page of the main section, while the fi rst few paragraphs of a 

less important story might begin on the next spread. The remainder of each article 

appears further back. In a magazine, the fi rst few pages of a long article might appear 

in one place and the fi nal pages might be relegated to the back of the magazine. In 

Publisher layout terms, the stories would fl ow through one or more text boxes on one 

page to text boxes on later pages. 

During the review process of a publication containing lengthy stories, you might fi nd 

that due to changes, additions, or deletions, you need to change the fl ow of a story. You 

can move the text boxes and pages containing content in the following ways: 

O To move a text box elsewhere on the same page, point to its outer border, and 

then when the pointer changes to a four-headed arrow, drag it to its new location. 

O To move a text box to a location on another page, do one of these two things: 

O Drag the text box into the scratch area, display the destination page, and 

then drag the text box to the desired location. 

O Cut the text box to the Clipboard, display the destination page, paste the text 

box (it appears either on the page or in the scratch area) and then drag it to 

the desired location. 

O To move a page to another location, drag the page icon in the page sorter. As 

you drag, a black arrow indicates the insertion location. Release the mouse button 

when the page is where you want it.



 Troubleshooting When you move a text box, its content moves with it, and it retains any 

links to other text boxes. Moving a linked text box or a page containing linked text boxes 

could result in segments of a story appearing out of order. 

Graphics Manager
In a multi-page publication that includes graphics, you can quickly view, locate, or 

replace graphics by using the Graphics Manager task pane. This task pane displays 

the fi le name and page number of all embedded or linked graphics in the publica-

tion, plus either the fi le size or a thumbnail of each graphic. 

You can sort the graphics list by fi le name, fi le extension, fi le size, page number, 

and status (embedded or linked). If you work with linked graphics, the Graphics 

Manager task pane identifi es any missing or modifi ed images that need your 

attention. 

To display the Graphics Manager task pane, click Graphics Manager on the Tools 

menu or in the task pane header list. 

When you point to a graphic in the Select A Picture list, a ScreenTip displays the 

fi le name, fi le extension, fi le size, page number, and status of the graphic, and an 

arrow appears. Clicking the arrow displays a menu from which you can move to 

and select the image, convert an embedded image to a linked image or vice versa, 

replace the image, or display additional image properties including scaling, resolu-

tion, and color model. 

Troubleshooting When you move a text box, its content moves with it, and it retains anyWhen you move a text box, its content moves with it, and it retains any

links to other text boxes. Moving a linked text box or a page containing linked text boxes links to other text boxes. Moving a linked text box or a page containing linked text boxes 

could result in segments of a story appearing out of order.could result in segments of a story appearing out of order.

Graphics Manager
In a multi-page publication that includes graphics, you can quickly view, locate, orIn a multi-page publication that includes graphics, you can quickly view, locate, or

replace graphics by using the Graphics Manager task pane. This task pane displaysreplace graphics by using the Graphics Manager task pane. This task pane displays

the fi le name and page number of all embedded or linked graphics in the publica-the fi le name and page number of all embedded or linked graphics in the publica-

tion, plus either the fi le size or a thumbnail of each graphic.tion, plus either the fi le size or a thumbnail of each graphic.

You can sort the graphics list by fi le name, fi le extension, fi le size, page number,You can sort the graphics list by fi le name, fi le extension, fi le size, page number,

and status (embedded or linked). If you work with linked graphics, the Graphics and status (embedded or linked). If you work with linked graphics, the Graphics 

Manager task pane identifi es any missing or modifi ed images that need your Manager task pane identifi es any missing or modifi ed images that need your 

attention.attention.

To display the Graphics Manager task pane, click Graphics Manager on the ToolsTo display the Graphics Manager task pane, click Graphics Manager on the Tools

menu or in the task pane header list.menu or in the task pane header list.

When you point to a graphic in the Select A Picture list, a ScreenTip displays the When you point to a graphic in the Select A Picture list, a ScreenTip displays the 

fi le name, fi le extension, fi le size, page number, and status of the graphic, and anfi le name, fi le extension, fi le size, page number, and status of the graphic, and an

arrow appears. Clicking the arrow displays a menu from which you can move to arrow appears. Clicking the arrow displays a menu from which you can move to 

and select the image, convert an embedded image to a linked image or vice versa, and select the image, convert an embedded image to a linked image or vice versa, 

replace the image, or display additional image properties including scaling, resolu-replace the image, or display additional image properties including scaling, resolu-

tion, and color model.tion, and color model.
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Solving Organization Problems
When you fl ow a story into one or more text boxes, the story might be too long or too 

short to conform to the allocated space. To address this type of problem, you can take 

one or more of the following actions: 

O Add or remove text. If you have editorial control over the content, you can add 

or remove a word, sentence, or paragraph to fi t the available space. Removing text 

is not necessarily a bad thing; just remember Mark Twain’s famous quote, “If I had 

more time, I’d have written a shorter book.” 

O Add, remove, or resize graphics. A picture might not be worth 1000 words, but it 

can easily be made to occupy the space of 20, 50, or 100 words. 

O Add, remove, or link to text boxes. Continue a long story into an additional text 

box on the same page or on another page. If a story does not require all the linked 

text boxes associated with it, you must manually break the forward links from the 

last occupied text box to the subsequent linked text boxes in the set. 

 Tip To cleanly disconnect multiple unused linked text boxes, move to the fi nal 

linked text box in the set by pressing the Go To Next Text Box button at the bottom 

of each text box. From the fi nal text box, press the Go To Previous Text Box but-

ton. Then on the Connect Text Boxes toolbar, click the Break Forward Link button. 

Continue this process until the last occupied text box is the fi nal box in the set. 

O Resize text boxes. This isn’t quite as simple a solution as it might sound. To make 

one text box taller, shorter, wider, or narrower, you will probably have to resize 

others, either to make space, fi ll space, or balance the design. 

To change the height of a set of identically sized text boxes simultaneously, select 

the fi rst text box, press and hold the Shift key, and select the other text boxes. (The 

Group button will appear.) Then drag the top or bottom handle of any one of the 

selected text boxes to resize them all. 

Drag the bottom
handle of either text
box to change the 
height of both.



O Change the layout of text within the text box or within the story. You can change 

the amount of white space that appears around the text in a text box (increasing the 

margin decreases the text area), change the number of columns within a text box, or 

change the number of text boxes that contain the story. For example, changing from 

three narrow columns of justifi ed paragraphs to two wider columns can be enough 

to shorten the content by a line or two. 

 Tip You can change the margins of a single text box from the Text Box tab of the 

Format Text Box dialog box. To automatically apply the modifi ed text box settings to 

all new text boxes added to the publication, select the Apply Settings To New Text 

Boxes check box on the Colors And Lines tab. 

O Change the font or font size of the story. If your design uses multiple fonts or 

sizes, you can apply one of the other available fonts or sizes to the story in a text 

box. However, changing to a font or size that is not used anywhere else in the pub-

lication can be distracting and look amateurish. 

 Tip You might be tempted to change the margins of a publication to try to change 

its footprint. You can relocate the blue margin guides by clicking Layout Guides on the 

Arrange menu and entering new top, bottom, left, and right margins on the Margin 

Guides tab. However, the layout of your publication does not change to refl ect the new 

margin settings, so this adjustment essentially has no effect on the footprint. 

In shorter publications such as fl yers and tri-fold brochures, it is reasonably simple to 

rearrange text boxes and resize content to appropriately fi ll the available space. Longer 

publications present additional challenges: You might need to conform to a 16-page 

signature for an offset-printed publication, to a 4-page footprint for each leaf added to 

a folded publication, or to a 2-page footprint for each leaf of a loose leaf, double-sided 

publication. After you insert all the content you intend to use in a publication and adjust 

the size of each story’s text boxes to fi t its content, you might fi nd that the publication is 

too long or too short to fi t the intended footprint. You might be able to fi x the problem 

by adding, removing, or changing individual stories, but if that is not possible, you can 

also solve the problem by making global changes to the publication. 

One way to manage the length of your publication is through your choice of font 

scheme. Different fonts have different height-to-width relationships—for example, the 

letter m is narrower in 12-point Calibri than it is in 12-point Verdana. The difference may 

be slight on a letter-by-letter basis, but it can be signifi cant when applied to an entire 

publication. 
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The Font Scheme list, both in the Getting Started window and in the Format Publication 

task pane, displays three pieces of information for each font scheme: the scheme name, 

the primary font, and the secondary font. The primary font is used for headings and 

titles, and the secondary font for body text. The names of the primary and secondary 

fonts are displayed in those fonts, providing a means by which you can gauge the effect 

each scheme will have on the length of your publication. 

Scheme name
Primary font
Secondary font

 Tip You cannot make changes to the font schemes that come with Publisher, but you can 

create a custom font scheme, either from scratch or based on an existing scheme. You can 

change, rename, and delete custom font schemes. 

In this exercise, you will trace the continuation of a story; move, insert, and delete pages; 

insert and remove Continued notices; format text in columns; and connect and discon-

nect text boxes. 



USE the ADatumNews publication. This practice fi le is located in the Documents\Microsoft 
Press\SBS_Publisher2007\TextPublications folder.

OPEN the ADatumNews publication, and close the Format Publication task pane.

 1. If you have a printer available, print the publication (double-sided, if possible) to 

make it easier to follow along with the exercise. 

 2. On the View menu, select Two-Page Spread if it is not already selected. Then on 

the page sorter, click the Page 2 button to display pages 2 and 3. 

The publication contains fi ve stories: Two start on page 1 and continue later in the 

publication, two start on page 2 and continue later in the publication, and one 

complete story appears on page 3. 

 3. On the page sorter, do the following: 

O Click the Page 4 button to display pages 4 and 5. 

The fi rst story beginning on page 2 continues on page 4 and ends halfway 

through page 5; the other half of the two-column text box on page 5 is 

empty. 

USE the the ADatumNewsADatumNews publication. This practice fi le is located in the publication. This practice fi le is located in the Documents\Microsoft Documents\Microsoft 
Press\SBS_Publisher2007\TextPublicationsPress\SBS_Publisher2007\TextPublications folder. folder.

OPEN the the ADatumNewsADatumNews publication, and close the Format Publication task pane.publication, and close the Format Publication task pane.
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 Tip You can follow the stories by clicking the Go To Previous Text Box and Go To 

Next Text Box buttons. 

O Display pages 6 and 7, then 8 and 9, and then 10 and 11. 

The second story beginning on page 2 continues on page 6 and runs through 

to page 10, ending partway down the left text box. 

The second story beginning on page 1 continues in the right text box on 

page 10, runs through page 11, and ends near the top of the left text box 

on page 12. 

O Display pages 12 and 13, and then click anywhere in the large text box on 

page 13. 

On page 12, most of the left text box is empty, and the right text box is en-

tirely empty. A sidebar relating to the story that ends at the top of the page 

spans the bottom of the page. 

The fi rst story beginning on page 1 continues on page 13. The Text In 

Overfl ow icon at the bottom of the page indicates that the story includes 

additional content that can’t be shown in the allocated space. 

O Display page 14. 

The last page of the publication is self-contained and complete. 



You need to reorganize the publication so that the stories continue in the order in 

which they begin. 

 4. Return to page 1. Click in the text box containing the story titled What’s New in 
Publisher 2007?, and then click the Go to Next Text Box button that appears below 

the text box. 

Publisher moves to page 13. The story does not connect to additional text boxes, 

so you need to move only this page to follow page 3. 

 5. On the View menu, click Two-Page Spread to turn off that view. 

 Tip In Two-Page Spread view, moving either page of a spread on the page sorter 

moves both pages. 

 6. On the page sorter, drag page 13 after page 3, so that it becomes page 4. 

You need to accommodate the part of the story that is not visible. 

 7. Click in the text box. On the Format menu, click Text Box, and then in the Format 
Text Box dialog box, display the Text Box tab. 

Go to Next 
Text Box

Go to Next 
Text Box
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 Tip The two Include “Continued” check boxes govern whether previous and next 

page numbers appear at the beginning and/or end of the selected text box. By 

default, you must manually select these check boxes for each text box in which you 

want the Continued text to appear. If you want one or both of these elements to 

appear by default, you can set your preferences here and then on the Colors And 

Lines tab, select the Apply Settings To New Text Boxes check box. 

 8. Clear the Include “Continued on page…” check box. Then click the Columns 
button. 

The Columns dialog box opens. 

 9. Change Number to 2, click OK, and then click OK in the Format Text Box dialog box. 

The text box contents fl ow into two columns, leaving considerable empty space at 

the bottom of the right column. However, the Text In Overfl ow icon indicates that 

additional text exists. 

 10. In the left column, click the picture. Then drag its lower-right handle up and to the 

left until the right edge of the picture aligns with the right edge of the column. 

When you release the handle, additional text and a graphic appear in the right 

column. 



 11. Repeat step 10 to resize the graphic in the right column to fi t the column. Then 

click in the text box. 

The Text In Overfl ow icon still appears. 

 12. On the Insert menu, click Duplicate Page to insert a new page 5 containing an 

empty two-column text box. 

 13. Display page 4, click in the text box, and then on the Connect Text Boxes toolbar, 

click the Create Text Box Link button. 

When you move the pointer back over the publication window, it changes to a 

pitcher. 

 14. Display page 5, and click in the text box. 

Additional content fi lls page 5. The Text In Overfl ow Icon still appears. 

 15. Right-click the text box, click Format Text Box, and then click the Text Box tab. 

Clear the Include “Continued from page…” check box, and then click OK. 

It is unnecessary to include continuation messages when a story appears on 

consecutive pages. 

 16. On the Insert menu, click Page, and in the Insert Newsletter Pages dialog box, 

click More. 

 The Insert Page dialog box opens. 

 17. Set the Number of new pages to 3, click the Duplicate all objects on page option, 

and then click OK. 

Publisher inserts four new pages (6, 7, and 8) containing empty two-column text 

boxes. The publication now has 18 pages. 

 18. Display page 5, and click in the text box. Click the Create Text Box Link button, 

display page 6, and click in the text box to continue the story. Repeat the process 

two times to continue the story through to page 8. Then resize each graphic to the 

width of its column. 

The story ends partway down the left column on page 8. 

 19. Click the text box, and then drag the bottom handle up to halfway through 

the content, releasing the mouse button when the content fi lls the two-column 

text box. 

Create Text 
Box Link

Create Text 
Box Link
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 Troubleshooting Be sure to size the window as shown in this graphic, or later steps 

might not work as expected. 

 20. Insert a copy of the text box at the bottom of the page, and size it to completely 

fi ll the available space. Using the skills you have learned, format the text box to 

include the “Continued from page” message when it contains text. 

You will continue the second story from page 1 in this text box. 

 21. Display page 1, click in the text box containing the story titled Plan Your Web Site, 

and then click the Go to Next Text Box button that appears. 

 Publisher moves to the second column on page 15. 

  22. Return to the previous text box, and on the Connect Text Boxes toolbar, click the 

Break Forward Link button. 

 The Text In Overfl ow icon appears. On pages 15 through 17, the text boxes that 

previously held the continued story are now empty. 

  23. Move page 16, which now contains an empty two-column text box, to become page 

9. Then use the skills you have learned to continue the second story that begins on 

page 1 (Plan Your Web Site) in the lower text box on page 8 and then in the text box 

on page 9. 

  24. Click the Go to Next Text Box button at the bottom of page 9. 

 Publisher moves to page 17, where the only content in the text box is the indicator 

of the end of the story (- END -). 

Troubleshooting Be sure to size the window as shown in this graphic, or later stepsBe sure to size the window as shown in this graphic, or later steps

might not work as expected.might not work as expected.

Break Forward 
Link

Break Forward 
Link



 Troubleshooting If your page 17 contains additional content, the likelihood is 

that you didn’t size the text boxes as we did on page 8 (see steps 19 and 20). You can 

correct this by returning to page 8 to decrease the height of the upper text box and 

increase the height of the lower text box. 

 25. Delete the end tag from the text box, and press the Z key to return the inser-

tion point to the end of page 9. Then click the Break Forward Link button to end 

the continuation of the story. 

The remaining two story continuations are in the correct order. 

 26. Use the skills you have learned to do the following: 

O End the fi rst story from page 2 (How to convert a trial version) in an evenly 

fi lled two-column text box on page 11. 

O Continue the second story from page 2 (Prepare, publish, and maintain) into a 

two-column text box at the bottom of page 11, through pages 12, 13, and 14, 

to end on page 15. 

 Tip The text boxes on pages 12–15 are already linked, so you need only link the text 

boxes on pages 2, 11, and 12. 

 27. On the page sorter, right-click the Page 16 button, click Delete Page, and then 

in the Microsoft Offi ce Publisher message box, click Yes to confi rm the deletion 

of the page, including the empty text box. 

Page 16 now contains an empty two-column text box and a sidebar. 

 28. Drag the sidebar into the gray scratch area to the side of the page. 

Troubleshooting If your page 17 contains additional content, the likelihood isIf your page 17 contains additional content, the likelihood is

that you didn’t size the text boxes as we did on page 8 (see steps 19 and 20). You canthat you didn’t size the text boxes as we did on page 8 (see steps 19 and 20). You can

correct this by returning to page 8 to decrease the height of the upper text box andcorrect this by returning to page 8 to decrease the height of the upper text box and

increase the height of the lower text box.increase the height of the lower text box.
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See Also For more information about the scratch area, see “Aligning and Stacking 
Objects” in Chapter 4, “Marketing Your Product, Service, or Organization.”

 29. Delete page 16, and then display page 15. Drag the sidebar from the scratch area 

to the empty space in the lower-left part of the page, and then size it to fi t the 

column width and display its contents. 

 30. Display the publication in Two-Page Spread view, and change the Zoom level to 

Whole Page. Review the 16-page publication to see the results of your work. 

 Tip Because this publication is double-sided, you must end with an even number 

of pages. 

 31. When you fi nish, update the page numbers in the table of contents on page 1 of 

the publication to refl ect the fi nal result. 

CLOSE the publication without saving your changes.



Editing and Proofi ng Content
For convenience, we have gathered together information about techniques for ensur-

ing the accuracy of your text in the last topic of this chapter. However, editing and 

proofi ng are processes that are on-going throughout the development of a publica-

tion. The language you choose to convey your message should be polished, targeted 

to your audience, and error-free. 

Editing Content in Word
If you are familiar with Microsoft Offi ce Word, you might be more comfortable crafting 

text by using Word tools and techniques than within a publication. Provided you have 

Word installed on your computer, you can simply right-click any text in a publication, 

point to Change Text, and then click Edit Story In Microsoft Word. A Word document 

containing the formatted text of the story opens, and Publisher indicates with cross-

hatching that the text box(es) containing the story are unavailable for editing. 

This pattern indicates that the story  
is open for editing in Word.

You can make content and formatting changes within the Word document. All the usual 

Word functions, including spelling and grammar review and word count, are available. 

When you fi nish, you close the document to return to Publisher. There is no need to save 

the document. (In fact, you cannot actually save the document, only a copy of it.) Your 

changes are immediately visible in the publication. 

 Tip You can insert comments and track changes in the document within the current Word 

session. However, when you close the document, all changes are accepted and comments 

removed before the content reappears in Publisher. 
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Correcting Spelling Errors
Before publishing a document, it is important to confi rm that it contains no spelling errors. 

In this electronic age, there are few excuses for the spelling errors that frequently occur in 

professionally printed materials. (This seems to be a particularly prevalent issue with res-

taurant menus!) Even in a short publication—but much more so in a long publication—err 

on the safe side, and use the tools that the 2007 Microsoft Offi ce system places at your 

disposal. 

Publisher provides two tools to help you with the chore of eliminating spelling errors: 

the AutoCorrect and Spelling features. It doesn’t include the grammar-checking feature 

available in Microsoft Offi ce Word and Microsoft Offi ce Outlook. However, if you dis-

play a story in Word as discussed earlier in this topic, you can run the full Spelling And 

Grammar feature. This is another great benefi t of the easy interaction between Publisher 

and Word. 

Have you noticed that Publisher automatically corrects some misspellings (such as teh to 

the) when you type them? This is the work of the AutoCorrect feature. AutoCorrect fi xes 

common spelling and typing errors so that you don’t have to. AutoCorrect comes with a 

long list of frequently mistyped words and their correct spellings. 

 Tip To open the AutoCorrect dialog box, click AutoCorrect Options on the Tools menu. 



If you frequently mistype a word that AutoCorrect doesn’t change, such as a diffi cult last 

name, you can add it to the list in the AutoCorrect dialog box. 

If you deliberately mistype a word and don’t want to accept the AutoCorrect change, 

you can undo the change by clicking the Undo button on the Standard toolbar or by 

pointing to the corrected word, clicking the AutoCorrect Options button that appears, 

and then clicking Change Back. 

A great time-saving trick for longer publications is to use the AutoCorrect feature to 

avoid having to manually enter phrases that occur frequently in your publications. For 

example, if you work on a project in which you often have to type For more information, 
see followed by a topic or chapter reference, you can enter a short combination of letters 

that does not form a word, such as fmi, and the full phrase to the list in the AutoCorrect 

dialog box. Thereafter, when you type fmi and press the Spacebar, AutoCorrect replaces 

the letter combination with the full phrase. 

Although AutoCorrect ensures that your documents are free of common misspellings, 

it cannot detect random typographical errors. To help you detect this type of error, 

Publisher includes the same spell-checking feature found in other Offi ce programs. By 

default, Publisher checks your spelling as you type and indicates suspected spelling 

errors with red wavy underlines. You can correct an individual error by right-clicking it 

and selecting a suggested alternative, or you can check the spelling of a single story or 

the entire publication by clicking Spelling on the Tools menu and correcting errors in the 

Check Spelling dialog box. 
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Over-reliance on spelling checkers has led to a modern-day misspelling epidemic. People 

seem to believe that just because a publication has passed a spell-check, it must be OK, 

but there are numerous common mistakes in word usage, for example using “their” in-

stead of “there,” that will pass a spell-check. In critical publications, take the time to use 

the Word grammar checker, which will catch many of these. The grammar checker indi-

cates questionable usage with a green wavy underline. 

Controlling Hyphenation
Many Publisher templates use text boxes to emulate the kinds of skinny-column layouts 

used in newspapers and magazines. To avoid leaving ugly gaps at the ends of lines and 

to make more content fi t in less vertical space, Publisher automatically hyphenates multi-

syllable words that fall within 0.25 inches of the edge of the text box. 

For each story, you can change the width of the default hyphenation zone, or you can 

turn off this feature entirely by right-clicking the story you want to change, pointing to 

Proofi ng Tools, and then clicking Hyphenation to display the Hyphenation dialog box. 

Clicking Manual displays a dialog box that moves from one hyphenated word to the 

next, allowing you to specify which words you want to hyphenate and how you want to 

hyphenate them. 

 Tip If you are going to manually hyphenate a story, ensure that all editing, including spell-

checking, is complete before you begin. It is a waste of time to fi ne-tune hyphenation if 

later changes might rewrap lines and necessitate another round of adjustments. 



To check the hyphenation settings of a story, you can click Options on the Tools menu, 

and then in the Options dialog box, click the Edit tab. 

Changing the settings under Hyphenation on this tab affects only new text boxes, not 

existing ones. 

In this exercise, you will create an advertisement, edit its content in Word, and check the 

spelling of the advertisement text. There is no practice fi le for this exercise. 

BE SURE TO start Publisher and close any open publications before beginning this exercise.

 1. In the Publication Types list, click Advertisements. 

Publisher offers six monochromatic designs, each available in square and rectan-

gular versions. If the active information set includes a logo, the design previews 

display the logo as well as the company name. 

 2. Under Microsoft Offi ce Online Templates, click View templates from Microsoft 
Offi ce Online. 

BE SURE TO start Publisher and close any open publications before beginning this exercise.start Publisher and close any open publications before beginning this exercise.
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If you have an active Internet connection, additional color advertisement templates 

provided by Microsoft (and possibly others) appear. Each Internet template is of a 

fi xed size, and has a rating based on feedback from Offi ce Online visitors. 

 Troubleshooting If you don’t have an active Internet connection, complete the 

exercise with any Publisher advertisement template. 

 3. Select a template you like, and then click Create. 

Publisher creates the selected advertisement. Placeholder text suggests the type 

of information you might include in each area of the advertisement. Blue dashes 

indicate placeholders linked to the information set. 

Troubleshooting If you don’t have an active Internet connection, complete theIf you don’t have an active Internet connection, complete the

exercise with any Publisher advertisement template.exercise with any Publisher advertisement template.



 4. Right-click the main placeholder text, point to Change Text, and then click Edit 
Story in Microsoft Word. 

 Troubleshooting If Word is not installed on your computer, skip to step 5, and 

then follow along with the rest of this exercise in Publisher. 

The text box becomes unavailable, and Word opens, displaying the placeholder 

text. 

See Also For information about working in Word 2007, refer to our book Microsoft 
Offi ce Word 2007 Step by Step (Microsoft Press, 2007).

Troubleshooting If Word is not installed on your computer, skip to step 5, andIf Word is not installed on your computer, skip to step 5, and

then follow along with the rest of this exercise in Publisher.then follow along with the rest of this exercise in Publisher.
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Your Word window might look different than the one shown here, depending on 

your settings. 

 5. In the text displayed in the document, remove a space from between two words to 

create a spelling error. 

Word immediately indicates the error with a red wavy underline. 

 6. Close the document to return to Publisher. After a short pause, the changed text 

appears in the advertisement. 

Publisher also indicates the misspelling with a red wavy underline. 

 Troubleshooting If you don’t see the wavy underline, point to Spelling on the 

Tools menu, and then click Spelling Options. Under When Correcting Spelling In 

Publisher, select the Check Spelling As You Type check box, and then click OK. 

 7. On the Tools menu, point to Spelling, and then click Spelling. 

The Check Spelling dialog box opens, prompting you to correct the error. Your 

publication is visible behind the dialog box so that you can easily locate the indi-

cated error in context—not important in a small publication such as this one, but 

very helpful in a longer publication. 

You can accept the suggested correction or enter any replacement text you want in 

the Change To box. Then click Change to effect the replacement and move to the 

next detected error in the story (if there is one). After checking the story, Publisher 

offers to check the remainder of the publication. 

Troubleshooting If you don’t see the wavy underline, point to Spelling on theIf you don’t see the wavy underline, point to Spelling on the

Tools menu, and then click Spelling Options. Under When Correcting Spelling In Tools menu, and then click Spelling Options. Under When Correcting Spelling In 

Publisher, select the Check Spelling As You Type check box, and then click OK.Publisher, select the Check Spelling As You Type check box, and then click OK.



 8. Finish checking the spelling of the publication content, and then in the Microsoft 
Offi ce Publisher dialog box that appears when the spelling check is complete, click OK. 

CLOSE the open publication without saving your changes, and if you are not continuing 

on to the next chapter, quit Publisher.

Key Points
O You can create a publication of any length by using Publisher. To save time, plan 

the design, content, and layout of the publication in advance. 

O When text does not fi t exactly in a text box, you have many options, including resiz-

ing the text and the text box. You can have Publisher automatically resize text to fi t 

the available space. 

O You can insert, delete, and move pages in a publication. Each page retains its 

content. Moving pages that contain continued stories might result in story sec-

tions being out of order. 

O You can edit story content in Word. All the program functionality other than saving 

the fi le is available. 

O Publisher includes tools for checking and correcting spelling and for controlling 

hyphenation. 
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Index

A
About Us, Web page template, 184
accent colors, 65
active text box, 31
address information, 136. See also information set
airplane templates, 136
alignment

of objects, xxxvi, 113

for paragraphs, 120

alleys, 114
defi ned, 195

anchor point, 33
anchoring graphics to text, 124
angle of text box, 31
anti-spam laws, 178
arrows on buttons, xii
artwork. See graphics
aspect ratio of graphics, 49
attributes of shapes, copying, 53
automatic save, time interval for, 10
AutoShape connectors, xxxii

B
back matter, 145

defi ned, 195

background
defi ned, 195

of page, 86

for publication, xxxiv

watermarks, 122

backup of publication, saving, 11
baseline guides, 113

defi ned, 195

binding, 97
in document planning, 134

bitmap (BMP) fi le format, 43
saving publication as, for e-mail, 171

blank pages, deleting headers and footers 
from, 146

blank publication, creating, xxix, 32
bleeds, 95

defi ned, 195

settings for, 24

BMP (bitmap) fi le format, 43
saving publication as, for e-mail, 171

body text, secondary font for, 150
bold font, 31, 37, 125
bookmarks

defi ned, 195

on Web pages, 189

borders, in Design Gallery, 59
brand, 100

defi ned, 195

brightness, 48
brochures, 119

formatting text in, 120

bulk mail, 84
defi ned, 195

bulleted list, 187
defi ned, 195

burning
CDs, 96

DVDs, 96

business cards, 20
Getting Started window for, 109

buttons, xii. See also toolbars

C
Calendar newsletter page layout, 137
Calendar, Web page template, 185
calendars, 84-92

adding captions or credits, 85

adding copyright notice, 85, 89

binding, 97

creating, xxxiv

specifying dates, 85

templates for, 63, 88

card stock
defi ned, 195

manually feeding to printer, 75

printing on, 75

cards, templates for, 63. See also folded cards
cascade view of multiple publications, 19
catalog merge, 78
categories for templates, xxviii, 14
CD, companion to book, xvii
CDs, creating, xxxv, 96
centering paragraphs, 120
Change Template window, xxvii, 7



character formatting
defi ned, 195

spacing, 31

chevrons
defi ned, 195

for mail merge data fi elds, 77

Chronological résumé template, 111
circle, creating, 52, 54. See also shapes
Classic Designs category, of envelopes, 105
clip art, 42-52

defi ned, 195

deleting from Clip Organizer, xxxi

inserting, xxxi

searching for, 42

Clip Organizer. See Microsoft Clip Organizer
clipboard, cutting text box to, 146
closing

publications, 10

task panes, 17

CMYK
color model, 67

composite output, 24

defi ned, 195

coil binding, 97
collating when printing, 27
color

cost of, 66

displaying purpose and name or value, 73

in document planning, 134

of fonts, 31, 36

impact of, 74

non-color-scheme, 68

of paper, 66

of shape line, 55

for shapes, 53

of text box, 30

of watermark, 122

color bars, 24
color gradient

defi ned, 195

for page background, 86

color scheme
Black & Gray, 138

for brochures, 124

creating, 65

defi ned, 195

in document planning, 135

for folded cards, 65

for invitation cards, 69

for Web pages, 189

column guides, 112
setting, 116

columns
fl owing text in multiple, 123

formatting text in, xxxviii

comb binding, 97

command button, confi guring on form, xli
comments, in Word, 159
companion CD, xvii
company information, storing, 20
company names, 101
compressing

defi ned, 195

graphics, 45

Connect Text Boxes toolbar, xxxvii, 123
Break Forward Link button, 148, 156

Create Text Box Link button, 128, 155

connecting shapes, 53-57
connection points, 53

defi ned, 195

Contact Us, Web page template, 185
Content Library, 58

adding items to, xxxvi, 104

editing category list, 108

Continued notices, inserting or removing, xxxviii
continuing a story, 123, 146

defi ned, 195

contrast, 48
cool colors, 74
coordinates

defi ned, 195

of text box, 33

copyfi tting text, 137
defi ned, 195

copying
attributes of shapes, 53

formatting, 37, 72

master pages, 87

text boxes, 30

copyright, 85, 102
adding notice to calendar, 89

defi ned, 196

cost
of binding, 97

of color, 66

coupons, in Design Gallery, 60
crop marks, 24, 95

defi ned, 196

cropping, xxxi
defi ned, 196

graphics, 45, 50

cross-hatching, in text boxes, 159
Curriculum Vitae résumé template, 111
custom font schemes, 150
custom styles, availability of, 121
custom templates, 14

changing, 14

creating publication based on, 14

Customize pane, Color Scheme list, 65
customized Design Gallery element, 58
cutting and pasting text boxes, 146
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D
data fi elds

defi ned, 196

for mail merge, 76

data source
defi ned, 196

for mail merge, xxxiii, 76

default fi le, for Web site home page, 184
default font scheme, reverting to, 142
default hyphenation zone, width of, 162
default Templates folder, 14
deleting

clip art from Clip Organizer, xxxi, 44

cropped area of image, xxxi

headers and footers from blank page, 146

master pages, 87

pages, xxxix, 157

Design Checker
for e-mail messages, 176, 180

to identify hidden objects, 113

Design Gallery, 58-61
Borders, 59

Coupons, 60

Dots, 60

inserting element from, xxxiii

for inserting table of contents object, 143

Logos, 106

design templates, 64
for calendar, 88

changing orientation and size, 70

desktop publishing, defi ned, 196
Device Independent Bitmap (.bmp) format, 

saving publication as, for e-mail, 171
dialog boxes

Add Clips to Organizer, xxx

Add Item to Content Library, xxxvi, 107

Advanced Printer Setup, 24

AutoCorrect, 89, 160

Business Information, 21

Character Spacing, 37

Check Spelling, xxxix, 161, 166

Colors, 67-68, 71

Columns, 123, 154

Command Button Properties, 192

Compress Pictures, xxxi, 51

Create New Business Information Set, xxix, 20, 22

Create New Color Scheme, 65

Edit WordArt Text, xxx, 39

Favorites, 44

Fill Effects, 41, 91, 122

Font, 36

Form Properties, 193

Format AutoShape, xxxii, 53-55

Format Picture, 47-49, 122-123, 129

Format Text Box, xxx, xxxviii, 30-31, 34, 123, 

137, 149, 153

Format WordArt, xxx, 41

Help button, xxiii

Hyphenation, 162

Import Styles, 121

Import To Collection, 44

Import Word Document, 8

Insert Address Block, 80

Insert Greeting Line, 82

Insert Newsletter Page, xxxviii, 141-142, 155

Insert Picture, xxxiv, 21, 49, 89, 107

Insert Text, 34

Insert Web Page, 191

Layout Guides, 116

Mail Merge Recipients, xxxiii, 80

Modify Style, 121

Navigation Bar Properties, xl, 188, 191

New Style, 121

Open Publication, xxviii, 6, 15, 17, 124

Options, xxvii, 10, 34, 163

Page Setup, 26, 70

Paragraph, 120

Print, xxix, 23-24, 26

Print Options, xxxv, 95

Publish to the Web, xl, 188

Recolor Picture, 48

Save As, xxviii, 10, 12, 96

Section, 146

Select Data Source, xxxiii, 79

Select Table, 79

Send As Message, 180-181

Suggested Verse, 70

Windows versions and, 9

with storage location, 10

direct mail services, 84
defi ned, 196

domain names, registering, 101
dots, in Design Gallery, 60
duplex, defi ned, 196
DVDs, burning, 96

E
Easy Web Site Builder, 184, 189
Easy Web Wizard, 184
editing text in Word, xxxix, 159, 165
e-mail merge, 178
e-mail messages, 170-177

creating, exercise, 172-177

creating from multi-page publication, 178-183

creating from template, xxxix

Design Checker for, 176

margins of, 173

 e-mail messages  203



e-mail messages (continued)
merging, xl

page size for, 172

sending publications as, xl

sending publications as attachments in, 170

templates for, 171

viewing source code of, xl, 175

Employee List, Web page template, 185
Entry Level résumé templates, 111
envelopes

creating, xxxv

with custom logo, 104

print settings for, 24

error messages, from Design Checker, 176

F
FAQ, Web page template, 185
Favorites - Microsoft Clip Organizer window, 44
Federal Trade Commission, spam 

regulations, 178
fi le name extensions, 13
fi le package, creating for fi le submission to 

professional printer, xxxv, 93-96
fi le size of graphic, compressing, 45
File Transfer Protocol (FTP) server, 183

defi ned, 196

fi les. See publications
fi ltered HTML fi les, 183

defi ned, 196

fl yers, 112
folded cards, 64-73

color scheme, 65

creating, xxxiii

design or layout choices, 64-65

text, 68

folders, for storing templates, 14
font colors, defi ned, 196
font effects, 31, 37

defi ned, 196

Font Scheme area, 150
font schemes, xxxviii, 104

for brochures, 124

custom, 150

in document planning, 135

and publication length, 149

reverting to template default, 142

for Web pages, 189

font sizes, 31, 125, 149
defi ned, 196

font styles, defi ned, 196
font substitution, print settings for, 24
fonts, 31

changing for story, 149

default set in templates, 104

defi ned, 196

effects, 31, 37

sizes, 31, 125, 149

footers, deleting from blank page, 146
footprint, 149

defi ned, 196

Format Publication task pane, xxvii, 7, 26, 32, 70
Color Schemes area, 65, 71

Extra Content pane, 181

Font Schemes area, xxxviii, 104, 108, 143

Invitation Options area, 70

formatting
brochure text, 120

characters, 31

copying, 37, 72

paragraphs, 120

shapes, xxxii

text, xxx

text boxes, xxx

Formatting toolbar, 120, 125
Align Text Right button, 125

Bold button, 125

Decrease Font Size, 72, 89

Fill Color, 53, 73

Font, 35, 104

Font Color, 36, 71, 122

Font Size arrow, 125

Increase Font Size, 35

Line Color, 73

Line/Border Style button, 53

Forms, Web page template, 185
forms, command button confi guration on, xli
frames

defi ned, 196

dragging, 30

moving to beginning or end of text in, 18

Frequently Asked Questions, Web page 
template, 185

front matter, 145
defi ned, 196

FTP server, 183
defi ned, 196

G
gallery, defi ned, 196
Genuine Advantage tool, 93
Getting Started window, 2

for assigning font scheme, 104

for business card, 109

displaying, xxvii, 4

publication type choices, 3

Recent Publications pane, xxviii, 15
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template thumbnails, 64

GIF (Graphics Interchange Format), 43
saving publication as, for e-mail, 171

grammar-checking, 160
in Word, 162

graphic fi le formats, 43
graphics. See also clip art; shapes

adding to Clip Organizer, xxx, 44

adding to Web pages, 188

adjusting, 148

anchoring to text, 124

aspect ratio of, 49

cropping, 50

enlarging, 118

grouping, 107

inserting from fi le, xxxi

inserting placeholder, 46

modifying appearance, 45-52

ownership of, 85

photographs, 42

positioning and sizing, 45

print settings for, 24

replacing, xxxiv

saving publication as, for e-mail, 171

size of, 48

for watermark, 122

wrapping text around, xxxvii, 123

Graphics Interchange Format (GIF), 43
saving publication as, for e-mail, 171

grayscale, 45
defi ned, 196

JPEG images, 43

output, 24

Greeting Cards, templates, 64
grid

changing proportions, xxxvi

defi ned, 196

guides, 112

page layout and, 114

grid guides, 112
defi ned, 196

grid units, defi ned, 196
grouping

defi ned, 196

graphics, 107

objects, selecting, xxxix

shapes, xxxii, 53-57

guides, 112

H
halftone screen settings, 24
handles

defi ned, 196

of frame, dragging, 30

headers, deleting from blank page, 146
headings, primary font for, 150
Help, xxiii

table of contents for, xxv

Help window for Publisher, xxiii
hidden objects, identifi ed by Design Checker, 113
hiding Publisher window, xii
home page, Web page template, 184
horizontally moving shapes, 53
hot spots, defi ned, 197
hovering, xii

defi ned, 197

HSL color model, 67
defi ned, 197

HTML, fi ltered fi les, 183
HTML-enabled e-mail, 170

viewing source, 175

hue, 67
hyperlink color, in color scheme, 65
hyphenation

controlling, 162

line breaks to override, 129

I
images. See graphics
importing Word document into publication, 

xxvii, 4, 8
indenting paragraphs, 120
index fi le, for Web site home page, 184
information set, 20

blue dotted underline as indicator, 70

creating, xxix

defi ned, 197

for e-mail details, 172

for envelope return address, 105

inserting
Continued notices, xxxviii

element from Design Gallery, xxxiii

external document into text box, xxx

graphics, xxxi, 47

pages, in newsletters, 137, 141

shapes, xxxii

installing, Microsoft Save As PDF Or XPS 
add-in, xxxv

Internet connection, for Microsoft 
templates, 164

Invitation Cards, 68
color scheme, 69

page size, 69

templates, 64, 171

italic font, 31
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J
Job List, Web page template, 185
JPEG (Joint Photographic Experts Group), 43

saving publication as, for e-mail, 171

K
keywords

adding to image, xxx

in Clip Art task pane, 42

in Clip Organizer, 44

defi ned, 197

in templates, 3

L
layout

adding guides to master page, 87

defi ned, 197

planning for longer document, 135

for table of contents object, 144

templates to help with, 3, 64

Layout option, in folded card template, 64
leaf, 149

defi ned, 197

Legal Information, Web page template, 185
letter-style communications, templates for 

e-mailing, 171
line break, 121, 126

defi ned, 197

to override hyphenation, 129

lines
between columns, 123

of text, white space between, 120

linked text boxes, xxxvii, 123
disconnecting multiple unused, 148

lists, 186
defi ned, 197

Lock Aspect Ratio setting, 49
logos

on business card, 21

in business information, xxix

creating, 103

defi ned, 197

in Design Gallery, 106

editing, xxxvi

envelopes with custom, 104

replacing placeholders with, 70

luminance, 67

M
magnifi cation (zoom level), xxviii, 16, 34
mail merge, 76

catalog merge, 78

defi ned, 197

for e-mail messages, xl, 178

Mail Merge Wizard, 79
mailing information, on newsletter, 136
Main color, in color scheme, 65
margin guides, defi ned, 197
margins, 114

changing for text box, 149

of e-mail message, 173

guides, 112

of publication, 32, 149

in text box, 31

master pages, 86-92
for calendar, 91

defi ned, 197

measurement units, display options, 34
merging. See mail merge
metadata

defi ned, 197

for Web pages, 189

Microsoft Clip Organizer, 44
adding image to, xxx, 44

adding keywords, xxx

defi ned, 197

deleting clip art image from, xxxi, 44

Microsoft Download Web site, 170
Microsoft Knowledge Base, xxvi
Microsoft Offi ce Online Web site, xxvi, 42

creating publication from template, xxxix

defi ned, 197

displaying available templates, 5

downloading sample publication, 3

graphics from, 47

Save As PDF Or XPS add-in from, 93

Microsoft Offi ce Outlook, 170
Microsoft Offi ce Publisher 2007

basics, xii

new features, ix-xii

opening, 4

program window, 6

starting, xii, xxvii, 32

Microsoft Offi ce Word
editing story, xxxix

editing text in, xxxix, 159

grammar-checking, 162

importing documents into publications, 

xxvii, 4, 8

Microsoft Outlook Express, 170
Microsoft Press Knowledge Base, xxiii
Microsoft Product Support Services, xxvi
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Microsoft Save As PDF or XPS add-in, xxxv, 170
Microsoft templates, Internet connection 

for, 164
moving

between pages, xxviii

pages in newsletters, xxxviii

publication content, 146

shapes, 53

text boxes, 30

muted colors, 74

N
names, of companies and organizations, 101
Navigation Bar

customizing links, xli

on Web pages, 189

News Articles, Web page template, 185
newsletters, 136-143

adding pages, xxxviii

copyfi tting text, 137

defi ned, 197

deleting pages, xxxix

inserting pages, 137

moving pages, xxxviii

templates for e-mailing, 171

nonprintable region of page, object in, 115
Normal style, changing, 126
numbered list, 187

defi ned, 197

O
objects

alignment of, xxxvi, 113

defi ned, 197

Design Checker to identify hidden, 113

in nonprintable region of page, 115

selecting group, xxxix

stacking, 113

text boxes as, 30

text fl ow around, 123

Objects toolbar, 32
AutoShapes button, xxxii, 54-55

Design Gallery Object button, xxxiii, xxxvi, 

58, 106

Insert WordArt button, xxx

Item From Content Library button, 109

Oval button, 54

Picture Frame button, xxxi, 46, 49, 107

Select Objects button, 174

Shape button, 52

Text Box button, xxix, 33, 89

WordArt button, 38, 39

Offi ce Online. See Microsoft Offi ce Online 
Web site

online printing services, 76
online viewing, publication design for, 171
opening

fi le as read-only, 16

multiple publications, 19

publications, xxviii, 15

Order Form newsletter page layout, 137
Order Form, Web page template, 185
organization names, 101
orientation of printing, 24, 26

changing for design template, 70

origami templates, 136
Outlook, 170
Outlook Express, 170
Oval shape, 52
ownership of artwork, 85

P
packaging publications for printing, xxxv, 93-96
page layout, 112

defi ned, 197

grid and, 114

page number formats, for section, 145
Page Size

in folded card template, 64

for invitation cards, 69

page sorter
defi ned, 197

deleting page, 157

displaying a page or spread, 14, 16

page templates. See Web page templates
pages

background of, 86

deleting, 157

master pages, 86-92

moving, 153

in newsletter xxxviii- xxxix, 137, 141

orientation of printing, 24

printing specifi c, 26

pages (continued)
size for e-mail, 172

types in document planning, 135

Pantone Matching System (PMS), 67
defi ned, 198

paper, 66
double-sided printing, 75

size, 26

paper airplane templates, 136
paper-folding templates, 136
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paragraph mark, formatting stored with, 121
paragraph section break, 145
paragraphs, 120

defi ned, 198

patents, 102
defi ned, 198

PDF (Portable Document Format) fi le, 93
sending as e-mail attachment, 170

personal information, storing in information 
set, 20

Photo Gallery, Web page template, 185
photographs, 42. See also graphics
physical size, in document planning, 134
Picture toolbar, 45

Compress Pictures button, xxxi, 51

Crop button, 50

Format Picture button, 47, 129

Line/Border Style button, 51

pictures, 42. See also graphics
defi ned, 198

pixels, 43
placeholders, 4

defi ned, 198

for graphics, 46

for text, 68 

in newsletter template, 138

replacing, xxxvii, 70

(PMS) Pantone Matching System, 67
defi ned, 198

PNG (Portable Network Graphic) format, 43
saving publication as, 171

points, 31
defi ned, 198

Portable Document Format (PDF) fi le, 93
defi ned, 198

sending as e-mail attachment, 170

positioning graphics, 45
postcards, 74

creating, xxxiii

mail merge, 76

tent-fold templates, 64

previewing publications, xxix, 23
primary font, 150
printer, manually feeding card stock, 75
printer’s marks, settings for, 24
printing

advanced settings for, 23

estimating cost, 66

online services, 76

packaging publications for, 93-96

previewing publications, xxix, 23

resolution for, 24, 52

specifi c pages, 26

two-sided, 27

process colors, 67
defi ned, 198

Product List With Links, Web page 
template, 185

production method, and document 
planning, 134

product-marketing messages, templates for 
e-mailing, 171

professional printing, creating CD or fi le 
package for submission, xxxv

Project List, Web page template, 185
proofreading, for résumés, 111
.pub fi le name extension, 13

sending as e-mail attachment, 170

public domain, 85
defi ned, 198

publication templates
airplane, 136

e-mail messages, 171

greeting cards, 64

invitation cards, 64

origami, 136

résumés, 111

publication type, 198
choosing in Getting Started window, 3

publications, 1. See also brochures; newsletters; 
résumés

adding existing to Web site, 188

assigning font scheme to, 104

binding, 97

custom template as basis, 14

defi ned, 198

importing Word documents, 4, 8

merging with data source, xxxiii

opening, xxviii, 15-16, 19

organizing content, 143, 145-146

packaging for printing, 93-96

planning, 134-135

printing, xxix, 23

saving, xxviii, 10, 11, 96

sending as e-mail message, xl

starting new, 2-3

Publisher 2007, getting help with, xxiii-xxvi
Publisher program window, xii

hiding, xii

publishing Web sites, 183

R
ragged edge for paragraphs, 120
read-only fi le

defi ned, 198

opening fi le as, 16

rectangle, 52. See also shapes
recto page, 145

defi ned, 198
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registering
domain names, 101

trademarks, 102

regroup, defi ned, 198
Related Links, Web page template, 185
removing Continued notices, xxxviii
repeating features, in document planning, 135
replacing placeholders with text or logo, 70
resolution, of graphics, 24, 52
Response Form newsletter page layout, 137
Response Form, Web page template, 185
résumé templates, 111
RGB

color model, 67

defi ned, 198

output, 24

rotating
defi ned, 198

graphics, 45

shapes, 53

rotating handle
for active text box, 31

defi ned, 198

row guides, 112
setting, 116

ruler guides, 113
defi ned, 198

ruler, in Web Site publication, 189

S
saddle-stitching, 97

defi ned, 198

saturation, 67
Save As PDF add-in, 170
Save As XPS add-in, 170
saving publications, xxviii, 10-11, 96

as templates, xxviii, 14, 135

as graphics, 171

multiple versions, 11

setting automatic time interval, 10

scanned photographs, JPEG for, 43
scratch area, 114

defi ned, 198

ScreenTips, xii, xxiii, 17
defi ned, 198

for graphics, 147

secondary font, 150
section opener, 145

defi ned, 198

sections
creating, 145

defi ned, 198

selected text, troubleshooting overwriting, 82
selecting

all text, 71

multiple shapes, 56

object group, xxxix

shapes, 52

text boxes, vs. text, 107

Separations output, 24
Service List, Web page template, 185
service marks, 102-111

defi ned, 199

shadows, for fonts, 31
shapes, 52-57

adding text, 52

connecting, xxxii, 53-57

copying attributes, 53

formatting, xxxii

grouping, 53-57, xxxii

inserting, xxxii

manipulating, 53

selecting multiple, 56

ungrouping, xxxii

signature, 149
defi ned, 199

Sign-Up Form newsletter page layout, 137
silk-screening, 103

defi ned, 199

sizing graphics, 45
sizing handles of object, dragging, 40
small caps, 31, 37
snapping

defi ned, 199

for objects, 113

sorting graphics list, 147
source code

for Web page, 175

viewing for e-mail, xl

spam regulations, 178
spell-check, xxxix, 111, 160, xxxix
spot colors, 67

defi ned, 199

spread, 18
defi ned, 199

square, drawing, 52. See also shapes
stacking objects, 113

defi ned, 199

order of, xxxvi

Standard toolbar
Columns button, 123

Format Painter button, 37, 53, 72

New button, 4, 32

Open button, 15, 124

Print button, 23

Print Preview button, 24, xxix

Save button, 10, 11

Zoom In/Zoom Out buttons, 16, 18-19, 34
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stapling
for binding, 97

defi ned, 199

starting Publisher 2007, xii xxvii
static information, in document planning, 135
status bar, xii

defi ned, 199

story
adding or removing text to fi t space, 148

continuing between text boxes, 123

defi ned, 199

editing in Word, xxxix

tracing continuation, xxxviii

Story newsletter page layout, 137
styles

defi ned, 199

of fonts, 31

for paragraphs, 121, 126

switching between task panes, xxxiv

T
table object, 186
table of contents

creating, 143

for Help, xxv

tables, 186
defi ned, 199

tabular list, 186
defi ned, 199

Tag Image File Format (TIFF), 43
saving publication as, for e-mail, 171

task panes. See also Format Publication task pane
Background, 91, 173

Clip Art, 42, 44, 46

closing, 17

Content Library, 108-109

Edit Master Pages, 86

E-mail Merge, 178

Graphics Manager, 147

Styles, 121, 127

switching between, xxxiv

Take To a Commercial Printing Service, 94

templates
for brochures, 119, 124

for calendars, 63

for cards, 63

for catalogs, 78

changing, 7

creating publications based on, xxvii

creating Web sites based on, xli

custom, 14

default font set, 104

defi ned, 199

in document planning, 135

for e-mail messages, 171, 172

for fl yers, 112

keywords in, 3

for newsletters, 136, 138

non-standard sizes, 136

saving publication as, xxviii, 14, 135

for Web pages, 184-185

for Web sites, 184

tent-fold templates, 64
text

adding to shapes, 52

adding to Web pages, 188

anchoring graphics to, 124

changing layout, 149

design in document planning, 135

editing in Word, xxxix, 159

on folded cards, 68

formatting, xxx

replacing placeholders with, 70

selecting all, 71

sizing to fi t text box, xxxvii

troubleshooting overwriting selected, 82

text boxes, 30-38
adding, xxix

with content, pointing to, 128

continuing stories between, 123, 146, 195

coordinates of, displaying, 33

copyfi tting text in, 137

copying, 30

cross-hatching in, 159

defi ned, 199

dimensions, displaying, 33

formatting, xxx

gradient fi ll for, 92

inserting external document into, xxx

linking, xxxvii

moving, 30, 146

sizing, 148

unlinking, xxxvii, 128

text fl ow
around objects, 123

around text box, 31

in multiple columns, 123

Text In Overfl ow icon, 89, 137, 139, 155-156
text watermark, 122
text wrap, changing for photograph, xxxvii
text-based publications

challenges, 133

creating, xxxvii

texture
defi ned, 199

for page background, 86

thumbnails
defi ned, 199

of publication types, 3
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of templates, 5

in WordArt, 38

TIFF (Tag Image File Format), 43
saving publication as, for e-mail, 171

tiled view, of multiple publications, 19
title bar, xii

defi ned, 199

toolbars. See also Connect Text Boxes toolbar; 
Formatting toolbar; Objects toolbar; Picture 
toolbar; Standard toolbar

AutoShapes, xxxii

Edit Master Pages, 86

Print Preview, 23-24

Web Tools, 190

WordArt, 40

tracking changes in Word, 159
trademarks, 102-111

defi ned, 199

troubleshooting
overwriting selected text, 82

pointing to text box with content, 128

selecting text box vs. text, 107

text box dimensions vs. position change, 36

two-sided printing, 27
Two-Sided Printing Setup Wizard, 75

U
underlining, 31
ungrouping

defi ned, 199

shapes, xxxii, 54, 56, 57

United States Federal Trade Commission, 178
United States Patent and Trademark Offi ce, 102
unlinking text boxes, xxxvii, 128

V
verso page, 145

defi ned, 199

vertical text alignment, in text box, 31
viewing publications, 15

changing, 16

publication design for online, 171

visited hyperlinks, color, 65

W
warm colors, 74
washout, 45

defi ned, 199

for watermark graphic, 122

watermarks, 122
creating, xxxvii

defi ned, 199

Web graphics, resolution for, 52
Web page templates, 184-185
Web sites, 184-193. See also Web page 

templates
adding existing publications to, 188

adding features to page, 189

adding pages, 185

adding publication as top-level page, xl

adding text and graphics to pages, 188

creating, xli, 189-193

publishing, 183

weight of shape line, 55
white space

between lines of paragraph, 120

changing in text box, 149

width, of default hyphenation zone, 162
Windows Mail, 170
WMF (Windows Metafi le), 43
Word. See Microsoft Offi ce Word
Word document, importing into publication, 

xxvii, 4, 8
word processing, 1, 199
WordArt, 38-42, 199

adding, xxx

best uses of, 38

modifying appearance, xxx

reactivating display, 40

X
XPS (XML Paper Specifi cation), 170

Z
zoom level, xxviii, 16, 34
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